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CONGRATULATIONS

Congratulations on the purchase of your new camera. Your camera has
been carefully engineered and manufactured to give you dependable
operation. Read this manual before operating the camera to become
more familiar with it.

E This manual has been written and formatted with depth and detail so that
you can easily follow the instructions to maximize the features of your

camera.



CAMERA OVERVIEW

CAMERA OVERVIEW

Top/Front

. Flash Ready LED
. Auto-Focus LED

. Viewfinder

. LCD

. LCD On/Off Button
. Tripod Socket

. Battery/Memory

Card Door

. Mode Switch
. Thumbnail/Wide/

Tele Zoom Button

. MENU Button
. Move up /

Flash ( 4 ) Button

. OK Button

LCD ICONS

27.
28.

29.

30.
31.

. Wrist Strap Holder
. Move to right /

Macro ( & ) Button

. Speaker
26.

Move down /
Self-Timer ( ®) )
Button

Memory Card Slot
Battery
Compartment
Move to left /
Continuous
Shot Button(Zy )
Reset Button
Delete Button

Resolution

G. Frame Counter

E#MCD

1. Power Button 7. Red-eye

2. Shutter Button Reduction LED/

3. Flash Self-Timer LED/

4. Lens/Lens Door AF Assist Light

5. Viewfinder 8. Port Cover

6. Flash Sensor 9. Mini-USB port
10. TV-Out port

Bottom/Back

1

12

[G] : Einzelbild
. Camera Mode  H. Macro - L °
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White Balance K. Memory Card 22 : Video Clips
. Battery Level
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Camera Features

3.1 Megapixels, 2048 x 1536 Resolution
1.5” Color LCD

3x Optical Zoom

4x Digital Zoom

AVI Video at 20fps at 320x240 or 160x120
Resolution

7 Preset Scenes, 2 Picture Effects
Macro Mode

Continuous Shooting Mode

Self-timer

Multi-Area Auto-Focus or Center Spot
Auto-Focus

6 MB Internal Memory, SD Card Slot
Compatible with Windows® 98/98SE/
2000/ME/XP and Mac OS 9.0 or higher
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GETTING STARTED

GETTING STARTED

ATTACHING THE WRIST STRAP

Be sure to use the wrist strap to avoid dropping the camera accidentally. When carrying the camera by the strap,
don't let it dangle to avoid shocks/damage to the exterior and/or interior of the camera.

24

fig.1.1

The camera uses 2x AA alkaline, lithium or rechargeable batteries. Rechargeable Batteries (NiMH) are highly

recommended.

fig.1.3

1. Slide the Battery/Memory Card door in the direction of the arrow, and lift it open. (fig.1.1)

2. Insert the batteries according to the polarity indication shown on the edge of the battery compartment.(fig.1.2)
3. Shut the Battery/Memory Card door by sliding it in the direction of the arrow, and close it securely. (fig.1.3)

TURNING THE CAMERA ON AND OFF

The Power Button is located at the top of the camera.
1. Press and hold the Power Button (@ ) for more than 1 second to turn the
camera on.

« The JENOPTIK logo will appear on the LCD for about 2 seconds.

« If the camera is in Camera Mode ([3] ) or Video Clip Mode ( ya@ ), the
lens cover will open, and the lens will extend out automatically to the
wide-angle position. Do not block the lens during extension.

* The LCD will turn on automatically and display live view.

2. To turn the camera off, press the Power (O ) Button.

Note: To extend battery life,

« The LCD will turn off after 1 minute of inactivity. After the LCD is automatically turned off, the Flash

Ready LED blinks. Press any buttons to reactivate the LCD.

« The camera will automatically power off after 2 minutes of inactivity by default.. Press and hold the

Power ( @ ) Button for more than 1 second to turn the camera back on.

REMOVING THE PROTECTIVE PLASTIC FILM

To prevent the LCD from possible scratches or damages during transportation, the LCD is covered with a clear

plastic film. Remember to remove the protective film for a clearer view of the subject when taking pictures.




GETTING STARTED

SETTING THE LANGUAGE, DATE AND TIME

When the camera is powered on for the first time, the Language, Date and Time menus will appear.

N =

@< LANGUAGE OPTION 4, DATEITIME SETUP

>i< ENGLISH 4 - 01-2004

== DEUTSCH 01:01AM

L FRANGAIS MM -DD - YYYY
CJEsPANOL 12-HOUR
W ITALIANO

RETURN SET RETURN SET

fig. 1.1 fig. 1.2

. Press A or y to highlight the desired language. (fig. 1.1)
. Press the OK button to select. The next screen will show the DATE/TIME SETUP page. (fig. 1.2)
. Press p to highlight the Date field, the Time field, the Date Format field or the Time Format field. The

selected segment will blink.

. Press A or ¥ to change the number in the blinking position, press p to go to the next field.
. Press the OK button to exit DATE/TIME setting. The next screen will display live view.

Note:

1.

2.

For each language, there is a default setting on Date format and TV broadcast standard. To change the TV
broadcast standard, refer to page 59..

Language(s) Date Format Setting TV Broadcast Standards
English / Espafiol / E#&& MM/DD/YYYY NTSC

Francis / Deutsch DD/MM/YYYY PAL

/Italiano/ Nederlands/Portugués

i YYYY/MM/DD PAL

If the batteries are removed or flat for about 4 minutes, the time setting will resume to factory settings. When
the camera is powered on again, the DATE/TIME setup screen will appear on the LCD. To reset date/time,
follow steps 2-5 above; to skip the date/time setting, press the OK button. You can set the date/time at a later
time. For instructions, refer to p.40.



GETTING STARTED

CHECKING THE BATTERY POWER LEVEL
The battery power level indicator represents the level of power of the batteries. The meaning of each icon is as
follows:

[l Battery power is

i N Battery power is
Batteries are fully not lfu.II, but it is still running low. Prepare
charged. suf'ﬁmgnt for camera a fresh set of
=) operations. batteries.

_—_ Battery power is low.

Replace or recharge Batteries are flat.
! (rechargeable Replace them
L] batteries only) as soon immediately.

as possible.

Note:

« The camera’s battery level indicator may not accurately reflect the actual power condition of the
rechargeable batteries, even if they have been fully recharged. This is an inherent problem with
rechargeable batteries, which is not related to the performance of the camera. For better performance,
Ni-MH rechargeable batteries are recommended.

+ Be sure to remove the batteries if the camera will not be used for an extended period of time to prevent
corrosion or battery leakage.

TURNING THE LCD/ICONS ON OR OFF

The camera is featured with a 1.5"LCD that is highly convenient for framing subjects during image/video capture,
reviewing stored images/video clips, and for on-screen display of the camera’s current settings.

1= BE==Ya

ﬁ Icons off 9 LCD off 9 LCD on with icons _I

Press the (|0 ) button repeatedly to toggle between the different LCD modes.

Note:

< To save battery power, it is recommended to turn off the LCD display.

< After one minute of inactivity, the LCD will automatically power off. When the LCD is auto-powered off,
the flash LED blinks. Press any button to resume the LCD.

« In (=] ) Review Mode, only the LCD icons can be turned on or off.



GETTING STARTED

INTERNAL MEMORY/INSERTING THE MEMORY CARD

Internal Memory
The camera is equipped with 6 MB of internal memory that can be used for storage as soon as you start taking
pictures or recording video clips.

Status Memory in Use
Memory card is not inserted. Internal Memory
Memory card is inserted. Memory Card

NOTE!: The files stored in the internal memory will remain there until the Transferring Files option is
selected. Refer to the Transferring Files section on page 35.

Inserting the Memory Card

D)

fig 1.1 fig.1.2 fig1.3

In addition to the 6 MB internal memory, the camera can use a Secure Digital (SD) memory card to store
images and/or video clips.

1. Slide the Battery/Memory Card door in the direction of the arrow and lift it open. (fig. 1.1)

2. Insert the memory card in the direction as shown in fig.1.2, then gently, but firmly push the SD card into the
slot as far as possible. NEVER forcefully push the card into the camera to avoid damaging both the card
and/or the camera. When the card is fully engaged, a click can be heard.

3. Close the Battery/Memory Card door properly and securely. (fig. 1.3)

After inserting the SD card, power on the camera, and the SD card will be checked for its compatibility with the
camera. If it is compatible, the camera will immediately accept it for storage. Otherwise, the camera will prompt
you to format the card before usage. To format the SD card, refer to p. 41.

Removing the Memory Card
1. Gently push the edge of the memory card with your fingertip to eject it.
2. Carefully pull out the card.

If the SD card is locked when the camera is powered on, the Shutter Button will be disabled. In this case, power
off the camera first, take out the SD card, gently slide the switch to unlock it, then reload the SD card into the
camera.

Note:
» Do not touch the metal contact plate of the SD card.
» The camera can support SD cards with storage capability of up to 512 MB.



GETTING STARTED / TAKING A PICTURE
SETTING THE CAMERA’S OPERATIONAL MODES

The camera has 3 operational modes: Camera Mode, Review Mode and Video Clip Mode.

To change the camera operational mode, slide the mode switch horizontally to the corresponding position.

@]]
olC

€ Ll
Camera Mode [>] Review Mode »& Video Mode
For taking pictures or For browsing images and For recording video clips or
customizing your camera video clips, deleting images customizing camera settings
settings for picture taking. and video clips, playing for video-clip recording.

a slide show, transferring

images and/or video clips
from the internal memory

to the SD card, or rotating
images.

TAKING PICTURES
LIVE VIEW THROUGH THE VIEWFINDER

1. Turn the camera on.
2. Setitto ([O]) Camera Mode.
(To save battery power, press the (|O) ) button to turn off the LCD display).
3. Aim the camera at the subject, then look through the Viewfinder to frame the desired object(s) to be included
in the photo. (fig.1.1)
Note: For better results, stand at least 2 ft (0.6m) away from the subject.
4. Press and hold the Shutter button halfway down to activate the Auto-Focus function until the green AF LED
stops blinking and the AF frame on the LCD changes to green. (fig.1.2)
(The camera will automatically determine the best focus, and a rapid click can be heard.)
5. Hold the camera steady with both hands, then firmly press the Shutter button down fully to capture the
image. (fig.1.3)
« When the image is captured, a beep can be heard.
« After an image has been captured, the Flash Ready LED next to the Viewfinder will blink to indicate
that the image is being stored.



TAKING A PICTURE

Flash Ready LED

Lit
The camera is
4 recording a video clip.

Blinking
The flash is recharging, or
LCD is in standby mode.

Note: When the camera is capturing or storing a picture or video clip, do not power the camera off; otherwise,
the picture or video clip may become corrupted.

LIVE VIEW THROUGH THE LCD

M= AEETE
1l <
: e P N
el

fig. 1.1

1. Turn the camera on.

2. Setitto ([0)) Camera Mode.
(If the LCD display is turned off, press the (|0 ) button repeatedly until the LCD display is on).

3. Aim the camera at the subject, then look at the LCD to frame the desired object(s) to be included in the
photo. (fig.1.1)
Note: For better results, stand at least 2 ft (0.6m) away from the subject in Normal Mode.

4. Press the Shutter button halfway down to activate the Auto-Focus function until the green AF LED stops
blinking and the AF frame on the LCD changes to green. (fig.1.2)
(The camera will automatically determine the best focus, and a rapid click can be heard.)
Note:
» For more information on Focus Lock, refer to p. 11.
» To change AF mode, refer to p. 24.

5. Hold the camera steady with both hands, then press and hold the Shutter button down fully to capture the
image. (fig.1.3)
» When the image is captured, a beep can be heard.
« After an image has been captured, the Flash Ready LED next to the Viewfinder will blink to indicate that

the image is being stored.

» Apreview of the image will be displayed on the LCD for a second. To change the preview time, refer to p. 42.
» The picture counter number displayed in the LCD will be updated.

6. If you are not satisfied with the captured image, simply press (@ ) button to delete it before it is saved. For
more information, refer to p. 30.

fig. 1.3
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TAKING A PICTURE

USING AUTO-FOCUS LOCK
When the subject is not located at the center of the picture, use this feature to lock the focus on the subject

before using the usual procedures to take a picture.

Auto-Focus LED
When the Shutter button is pressed halfway, the Auto-Focus feature will be activated and the Auto Focus

(green) LED will display the status of the Auto-Focus lock.

o —
(d
Lit Blinking
The subject is in The camera is adjusting
| | focus. the focus.
Auto-Focus Frame
Auto-Focus Frame
AF Frame Color Description
White Not in focus.
Green The subject(s) is in focus.

Using the focus lock:

fig. 11
1. Aim the camera so that the AF frame at the center of the LCD screen is positioned on the “off-centered”

subject . (fig.1.1)
2. Hold the camera steady with both hands, then press and hold the Shutter button halfway down until the AF

frame changes to green and the green AF LED stops blinking. (fig.1.2)

3. Recompose your picture. (fig.1.3)
(Be sure to press and hold the Shutter button down halfway while recomposing the picture.)

4. To capture the picture, press the Shutter button down fully. (fig.1.4)

Note: The AF LED will continue to blink in the following conditions:
1. There are several subjects at different distances within the focus lock area. Recompose the picture by

moving the camera slightly.
2. There is no color contrast. Recompose the picture with a subject that contains more color.
3. There is insufficient lighting. Increase the lighting in the surrounding area.
4. Please refer to P.11 to change Auto Focus mode and refer to P.24 to change AF assist light setting.

11




TAKING A PICTURE

SETTING THE FLASH

fig. 1.1 fig. 1.2

To set the flash:
Press A / 5 repeatedly until the desired indicator appears on the LCD.

Flash Mode Description
5A Auto Flash (Default) The camera judges if a flash is required. If the environment is too dark,
the flash will fire.
5A© Auto + Red-Eye Use this mode to reduce the occurrence of “red-eyes” when taking pictures

with a flash. The camera will automatically detect when the flash is needed
and the flash will fire after a short delay.

5 Flash ON Flash will fire in any lighting condition. The “red-eye” reduction function also
included in this mode.
@ Flash OFF In this mode, the flash will not fire, regardless of the lighting condition. Use

this mode to capture the mood of ambient lighting. This mode is also useful

for places that prohibit flash photography, such as museums, aquarium,

archeological exhibitions, etc.

« To prevent blurry pictures in dim-lighting environment, hold the camera
steady when pressing the Shutter button or mount the camera on a tripod.

Note:

» The flash needs to recharge after it is fired. If the Shutter button is pressed when the flash is
charging, the Flash Ready LED will blink. Wait for a short while, then press the Shutter button again to
take a picture.

» Some of the scene selection will deactivate the flash setting. For more information, refer to p. 20.

12




TAKING A PICTURE

USING THE OPTICAL ZOOM
The camera provides up to 3x optical zoom to take pictures.

127 am

- o
fig. 1.1 fig. 1.2 fig. 1.3
1. Press T (Tele) to zoom in to your subject.

The optical zoom status is displayed in white in the zoom bar on the LCD( Wl =——) ).
2. Press W (Wide) to zoom out.

USING THE DIGITAL ZOOM

The camera also provides 4x Digital Zoom. Combined with the 3x Optical Zoom, it can provide up to 12x
magnification of your pictures.

fig. 1.2

How to use digital zoom:

1. Turn the LCD on.

2. Press T until the white optical zoom bar reached the mid-marker (Il ==——{)

3. Continue to press T to activate the digital zoom. The digital zoom status is shown in blue in the zoom bar on
the LCD ( i m=—=—m))).
« Allow for a short delay before the digital zoom can be activated.

4. Press W to zoom out.

Activating/Deactivating Digital Zoom

CAMERA MODE 4] SETUP
53§ FORMAT >
B DATE/TIME SETUP »
<t BEEP >
B QUICK VIEW
RETURN SELECT RETURN SELECT RETURN SET
fig. 1.1 fig. 1.2 fig. 1.3
1. In Camera Mode, press MENU to display the Main Menu.
2. Press ¥y repeatedly until SETUP is highlighted, then press P to enter its submenu.
3. Press ¥ repeatedly until Digital Zoom is highlighted, then press P to enter its submenu.
4. Press g4 or ¥ to highlight Yes or No.
« By default, it is set to On.
5. Press OK to select.

13



TAKING A PICTURE

Important:

1. Hold your camera steady when using Digital Zoom to prevent blurred photos, caused by jittery movement. It
is recommended to either place your camera on a steady surface or mount it on a tripod.

2. The image quality may degrade slightly with Digital Zoom.

3. Digital Zoom can only be monitored with the LCD and not through the optical viewfinder.

TAKING PICTURES IN MACRO MODE (CLOSE-UP SHOTS)

This mode enables the camera to capture pictures in close distances.

. Press the B button. The Macro icon ( < ) will be displayed on the LCD.

2. Frame the subject in the LCD.
« The best shooting range is between 15 cm to 60 cm. (5.9 in. — 23.6 in.)

3. Press and hold the Shutter button halfway to activate the Auto-Focus function until the green AF LED stops
blinking and the AF frame changes to green.

4. Press the shutter button fully to take the picture.

N

Note:
1. When Macro Mode is selected, the camera will turn on the LCD if it is automatically turned off.
2. Zoom buttons do not work in Macro Mode.

TAKING CONTINUOUS SHOTS

This feature enables the camera to continuously capture 7 consecutive pictures with VGA (640x480) resolution
when the Shutter button is pressed and held.

. Press the « button. The Continuous Shot icon (@ ) will be displayed on the LCD.
2. Frame the subject in the LCD screen, press and hold the Shutter button halfway to activate the Auto-Focus
function until the green AF LED stops blinking and the AF frame changes to green.
3. Press and hold the Shutter button down fully to capture the pictures.
« The camera will automatically and continuously capture 7 consecutive images at approximately 3
images per second in 640 x 480 resolution.
4. To exit the Continuous Shot function, press the « button until I disappears from the LCD.

N

Note:

« In Continuous Shooting Mode the flash is disabled, as the recharging time will slow it down.
« The camera will only capture pictures in 640 x 480 resolution in Continuous Shooting Mode.
» The LCD will be blank when the images are taken in the Continuous Shooting Mode.

14



TAKING A PICTURE
TAKING PICTURES WITH SELF-TIMER

1. In ([O] ) Camera Mode, press ¥ button, the Self-Timer icon () ) will appear on the LCD.

2. Place the camera on a flat surface or tripod.

3. Use the LCD to compose the picture, then press the Shutter button to activate the Self-Timer.
The Self -Timer LED will blink slowly for 7 seconds, faster for the remaining 3 seconds, then the image will
be captured.

Note:

« The Self-Timer is automatically deactivated once the image is taken.

+ To deactivate the Self-Timer before taking a picture, press ¥ button until the Self-Timer icon () )
disappears from the LCD.

Photography Hints -

Since the Self-Timer LED indicator at the front of the camera flashes, the photographer will have time to join in
the photograph and know when the camera has completed taking a picture when the Self-Timer LED light stops
blinking.

15



TAKING A PICTURE

USING THE MAIN MENU IN CAMERA MODE

Q QUALITY SETUP
F%% FINE

*% NORMAL 4

*  ECONOMY

RETURN SET

[["j AUTO-FOCUS
[ 5SPOT

[-IMULTI-AREA

RETURN SET
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SCENE SELECTION

CAMERA MODE
CAPTURE MODE b
QUALITY SETUP b
IMAGE SIZE »
SCENE SELECTION P
#g WHITE BALANCE >
RETURN SELECT EE WHITE BALANCE
P AWB AUTO v
CAMERA MODE ¥ SUNNY
PICTURE EFFECT P g :b‘:“;iﬁz‘zm
EV COMPENSATION b &
#° 1SO >
METERING »> RETURN
[’3 AUTO FOCUS »> ——————————
RETURN SELECT % PICTURE EFFECT
— (X) OFF v
CAMERA MODE [ Baw
114 sETuP SEPIA
RETURN
RETURN SELECT
#° 150
% 100
& 200
8 400
RETURN SET

CAPTURE MODE

@@@i

ry

&

RETURN SET

IMAGE SIZE
2048 x 1536

1600 x 1200

1024 x 768

u 640 x 480

RETURN SET

(X) OFF
PARTY / INDOOR
[8] snow
BEACH
[ SUNSET
RETURN SET

fiad SCENE SELECTION
NIGHT LANDSCAPE
FIREWORKS
PR NIGHT PORTRAIT

RETURN SET

RETURN SET



TAKING A PICTURE

USING THE MAIN MENU IN CAMERA MODE

Follow the steps below to set the advanced shooting options in the camera through the Main Menu.

. Turn the camera on.
Set the camera to ([O] ) Camera Mode.
. Press the MENU button to display the Main Menu.
Press A or ¥y repeatedly until the desired option is highlighted.
Press p to enter the submenu.
. Press A or y repeatedly in the submenu to toggle between the options.
. Press the OK button to make a selection.
« All selections will be marked by a red check mark.
8. To return to the previous menu, press « .
9. To exit the menu at any time, press the MENU button.

NooswN

SETTING CAPTURE MODE
The capture mode menu has 4 features to choose for taking pictures.

Capture Mode Option Description
() Single The camera will take 1 picture at a time.
( & ) Continuous Shooting The camera will continuously take 7 consecutive pictures (at 640 x 480

resolution) when the Shutter button is fully pressed.
The flash is disabled in this mode.

( ) Sport The camera will take 1 picture at a time in Sport Mode.

( &l + = ) Continuous Shooting | The camera will continuously take 7 consecutive pictures in Sport Mode
with Sport

Note: Flash will be deactivated in Continuous Shooting Mode.

TAKING PICTURES IN SPORT MODE
This mode is used for taking pictures of sports and other high-speed activities. The camera will automatically
choose a higher shutter speed and wider aperture to capture fast-moving action to avoid blurriness.

Setting Sport Mode:

CAMERA MODE

13 CAPTURE MODE »

Q QUALITY SETUP >
{8 IMAGE SIZE »
kd SCENE SELECTION P
#3 WHITEBALANCE b
RETURN SELECT

% CAPTURE MODE

RETURN SET

1. In the main menu, press p to enter the Capture Mode submenu.
2. Press A or ¥ to highlight Sport ( & ) or Sport + Continuous Shooting ( &l + & ).
3. Press OK to enter the mode.

Taking a picture in Sport Mode:

1. Frame the subject in the LCD.

2. Press and hold the Shutter button halfway to activate the focus until the green AF LED stops blinking and
the AF frame changes to green.

3. Press the Shutter button down fully to take the picture.

17



TAKING A PICTURE

Note: Hold your camera steady to prevent blurriness. It is recommended to either place your camera on a

flat, steady surface or mount it on a tripod.

SETTING IMAGE QUALITY

The Image Quality setting determines the amount of compression used to reduce the size of the stored image
file in order to economize space in the memory.

CAMERA MODE

IMAGE SIZE

#4 WHITE BALANCE
RETURN SELECT

1% CAPTURE MODE »

>
fad SCENE SELECTION b
>

Q QUALITY SETUP

*% % FINE
*% NORMAL 4
*  ECONOMY

RETURN SET

Quality JPEG Compression Ratio Description

Fine 4.5:1 Fine image quality can be used for making prints.

Normal 11:1 Normal image quality can be used for general purpose pictures.
(Default)

Economy 17:1

Economy image quality can be used for pictures that will be sent

via e-mail.

To change the image quality:

1. When (Q ) QUALITY SETUP is highlighted, press p to enter the ( Q ) Quality Setup submenu.

. Press A or ¥y repeatedly until the desired setting is highlighted.

2
3. Press the OK button to select the Quality Mode.
4. Press the MENU button to return to picture taking mode.

Note: The default Quality is set at NORMAL.

SETTING IMAGE RESOLUTION

Image Resolution determines the size of a captured image. Higher resolution images contain more details and

have larger file sizes.

(7w

i
7%
b

i

Y

CAMERA MODE

12 CAPTURE MODE

>
Q QUALITY SETUP »
»

2 IMAGE SIZE

2048 x 1536 v
00 x 1200

1024 x 768

kd SCENE SELECTION b Ve 640x480
¥#J WHITE BALANCE b
RETURN SELECT SET
Images Stored on 6MB memory (approx.):

Resolution 3MP 2MP 1.3MP VGA
Quality (2048 x 1536) (1600 x 1200) (1024 x 768) (640 x 480)
Fine (4.5:1) 4 6 14 36
Normal (11:1) 13 32 79
Economy (17:1) 15 23 55 130

18



TAKING A PICTURE

Images Stored on 16MB memory (approx.):

Resolution 3MP 2MP 1.3MP VGA
Quality (2048 x 1536) (1600 x 1200) (1024 x 768) (640 x 480)
Fine 9 14 33 82
Normal 19 31 74 181
Economy 34 53 125 297

Images Stored on 32MB memory (approx.):

Resolution 3MP 2MP 1.3MP VGA
Quality (2048 x 1536) (1600 x 1200) (1024 x 768) (640 x 480)
Fine 20 29 68 171
Normal 41 65 154 376
Economy 71 111 261 616

Images Stored on 64MB memory (approx.):

Resolution 3MP 2MP 1.3MP VGA
Quality (2048 x 1536) (1600 x 1200) (1024 x 768) (640 x 480)
Fine 42 60 140 351
Normal 84 135 316 771
Economy 146 229 536 1270

Images Stored on 128MB memory (approx.):

Resolution 3MP 2MP 1.3MP VGA
Quality (2048 x 1536) (1600 x 1200) (1024 x 768) (640 x 480)
Fine 83 119 279 698
Normal 167 268 628 1532
Economy 290 455 1064 2512

How to change the resolution:

1.
2
3.
4. Press the MENU button to return to the picture-taking mode.

When Resolution is highlighted in the Main Menu, press P to enter the ( % ) Resolution submenu.

. Press A or ¥ repeatedly until the desired setting is highlighted.
Press the OK button to select the mode

Note: The default image resolution is 3MP.
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TAKING A PICTURE

SELECTING SCENE MODES

The preset scene modes are helpful to quickly optimize the various settings to get the best capture of specific

scenes.

fad SCENE SELECTION

OFF v

PARTY / INDOOR

CAMERA MODE

CAPTURE MODE
QUALITY SETUP

[id SCENE SELECTION [ BEACH
#g WHITE BALANCE =9 sunseT
RETURN SELECT RETURN SET

>
| 4
i IMAGE SIZE » [8] snow
»
>

Preset Scene

Description

Off (default)

No Scene Selection.

Party/Indoor

Use this mode to capture the details of candlelit scenes or other indoor
background lighting conditions.

m Snow

Use this mode to capture snow scenes, and prevent the image from losing color.

Beach

Use this mode to capture the details in shining water scenes.

Sunset

This mode captures the deep hues and color variations in sunsets and sunrises.

Night Landscape

A slow shutter speed is used to capture the lights in night scenes.

Photography Tip: With the slower shutter speed, there is a possibility of causing
blurry images, due to camera movement.

To reduce the degree of blurriness, you may:

1. Set your camera to Night Landscape mode.

2. Place your camera on a tripod or sturdy surface area.

3. Set the camera to Self-Timer mode.

4. Press the shutter button.

Fireworks

Use this mode to capture the burst of light from fireworks with a slower shutter
speed.

Night Portrait

Use this mode to capture a subject illuminated with the lights in a night scene with

a slow shutter speed.

« Due to the slow shutter speed, mount the camera onto a tripod for better picture
quality.

To set the scene selection:

1. When Scenes Select is highlighted, press P to enter its submenu.
2. In the Scene menu, press A or ¥ to choose between the options.
3. Press the OK button to select the Scene Mode.

4. Press the MENU button to return to picture taking mode.

Note: Change of the flash setting will deactivate the scene setting selected in Scene Selection

20




TAKING A PICTURE

SETTING WHITE BALANCE

By default the camera uses Auto White Balance to reproduce colors under different lighting conditions. For
mixed lighting conditions, it is recommended to use the Auto White Balance option.

CAMERA MODE 78 WHITE BALANCE
CAPTURE MODE AWB AUTO v

>
QUALITY SETUP > 16 SUNNY
>

IMAGE SIZE == FLUORESCENT
SCENE SELECTION b H. TUNGSTEN

¥g WHITE BALANCE »

RETURN SELECT RETURN SET

White Balance Mode Description
[A] Auto The camera will automatically choose the white balance setting. Use this
setting in variable conditions.
% Sunny For outdoors with sufficient sunlight.
™ Fluorescent For indoors with fluorescent or ambient lighting conditions.
£ Tungsten For indoors with tungsten lighting conditions.

To change the White Balance:

1. When White Balance is highlighted, press P to enter its submenu.
2. Press A or ¥ repeatedly until the desired setting is highlighted.
3. Press the OK button to select the White Balance mode.

4. Press the MENU button to return to picture-taking mode.

SELECTING THE PICTURE EFFECT

You can shoot with different picture effects.

Picture Effect Description
OFF (Default) Taking pictures without effect.

B&W Taking pictures in black and white.

SEPIA Taking pictures in sepia tones like old pictures.

CAMERA MODE % PICTURE EFFECT

7 PoTurc errect

V| EV COMPENSATION b | Baw

0 1SO > SEPIA

B METERING >
['5 AUTO FOCUS >
RETURN SELECT RETURN SET

To set photo effect:

1. When Picture Effect is highlighted, press p to enter its submenu.
2. Press A or ¥ repeatedly until the desired setting is highlighted.
3. Press the OK button to select the picture effect.

4. Press the MENU button to return to the picture-taking mode.
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TAKING A PICTURE

SETTING EXPOSURE COMPENSATION

The camera uses Auto Exposure to give well-exposed pictures under most lighting conditions. If the captured
picture of the main subject turns out to be too light or too dark, use the Exposure Compensation feature to
improve the exposure aspect.

CAMERA MODE
% PICTURE EFFECT b

EV COMPENSATION P~
>

#° 10
B METERING > /
£ AUTO FOCUS > i i
RETURN SELECT e 0K i n

Exposure Compensation
Mode

Description

Increasing the Exposure in pictures that are too dark, will make the

* picture lighter.

Decreasing the Exposure in pictures that are too light, will make the
picture darker.

To change the Exposure Compensation level:
1. Press A or ¥ repeatedly in the Main Menu until ( ) Exposure Compensation is highlighted.
2. Press p display the Exposure Compensation bar on the LCD.
3. Press4q or p to change the Exposure Compensation between — 2.0 to +2.0.
4. Press the OK button to select the desired value.
* The camera will return to the picture-taking mode automatically after selection.
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TAKING A PICTURE

SETTING THE ISO SENSITIVITY
Raise the ISO speed when you wish to reduce jittery camera movement or to turn the flash off when shooting in
dark surroundings.

ISO Setting Description
#. Auto (default) Equivalent to setting of ISO 100 under normal conditions. When lighting is poor,
camera raises sensitivity automatically to compensate.
% 100 100 is best for shooting clear, sharp images in daylight.
4 200 200 is ideal for shooting in cloudy situations.
% 400 400 is best for shooting in dark surroundings, for example, especially at night.

Note: Higher ISO speeds increase image noise. To take clean images, use as low an ISO speed as
possible.

TO CHANGE ISO SETTING:

CAMERA MODE #° 10

% poreerrecT >

EV COMPENSATION b %% 100

o 200
BH METERING » #a 400
['5 AUTO FOCUS >
RETURN SELECT RETURN SET

. When ( #? ) ISO is highlighted, press B to enter its submenu.

. Press A or W repeatedly until the desired setting is highlighted.
. Press the OK button to select the ISO setting.

. Press the MENU button to return to the picture-taking mode.

B WN =
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TAKING A PICTURE

SETTING LIGHT METERING MODE
You can choose the desired part of the image to use for measuring the brightness and determine the exposure.

Metering Mode

Description

Spot

Meters the light in the center area of the image. Use this mode when the subject is
backlit or surrounded by strong light.

Matrix(default)

Metering the light in different zones. Use this mode when the lighting condition

is complex. The camera can adjust the settings to correct exposure for the main
subject by metering the position of the subject, the brightness, the direct light, and
the backlighting etc.

To change Light Metering mode:

AWN o

CAMERA MODE FF] METERING
% PICTURE EFFECT b [)SPOT

% ey compensaTion »
»

@@ 1SO
[ AUTO FOCUS >
RETURN SELECT RETURN SET

. When ( ) Metering is highlighted, press p to enter its submenu.
. Press A or wy repeatedly until the desired setting is highlighted.

. Press the OK button to select the Metering Mode.

. Press the MENU button to return to the picture-taking mode.

SETTING AUTO FOCUS (AF) MODE
The camera provides two AF modes to perform the Auto Focus function.

AF Mode

Description

Spot

In this mode, the camera uses the center zone of the subject to perform auto
focusing. Use this mode when you want to focus only what you aim at.

Multi-Area (default)

In this mode, the camera automatically determines which area (center,
upper-left, upper-right, lower-left, lower-right) is best to perform the auto
focusing function. Use this mode when the lighting condition is complex.

To set AF mode:

AWN o

CAMERA MODE [*JAUTO-FOCUS

% PICTURE EFFECT b [5SPOT
W EV COMPENSATION b [-]MULTI-AREA

#0150
[ METERING

[* AUTO FOCUS

RETURN SELECT RETURN SET

. When AF mode is highlighted, press p to enter its submenu.

. Press A or y repeatedly until the desired setting is highlighted.
. Press the OK button to select the AF Mode.

. Press the MENU button to return to picture taking mode.
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TAKING VIDEO CLIPS
TAKING VIDEO CLIPS
TAKING VIDEO CLIPS

To record a video clip:

1. Slide the Mode Switch to ( s ) Video Clip Mode.
« The time limit is showed on the upper-right corner of the screen.

2. Position the subject in the LCD.

3. Press the Shutter button down fully to start recording a video clip. The time recorded will be shown on LCD.
The camera records a video clip until the memory is full.

To stop recording:

1. Press the Shutter button again to stop recording.

OR

2. The camera will stop recording only after the memory is full.

Video Clip Information

Resolution: QVGA (320x240) or QQVGA (160x120) (Best for e-mail)
Frame rate: 20fps
File Format: AVI (Motion Picture)

Note:

« Do not open the battery door or turn the camera off when recording. Otherwise, the video clip may not be
stored.

« Higher capacity memory cards can record video clips for a longer duration.

* The Flash, Macro, and Continuous Shooting are deactivated in Video Mode.
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TAKING VIDEO CLIPS

RECORDING A VIDEO CLIP WITH THE SELF-TIMER

-

. Inthe ( ¥ ) Video Clip Mode, press ¥ button, and the Self-Timer icon () ) will appear on the LCD.
. Place the camera on a flat surface or mount it on a tripod.
. Use the LCD to compose the picture, then press the Shutter button to activate the Self-Timer.

The Self -Timer LED will blink slowly for 7 seconds, faster for the remaining 3 seconds then starts recording.

memory limit is reached.

USING THE MAIN MENU IN VIDEO CLIP MODE

#3 WHITE BALANCE

AWB AWB v

Xt SUNNY
== FLUORESCENT
B TUNGSTEN

"% VIDEO MODE RETURN SET

% PICTURE EFFECTS P
P”] EVCOMPENSATION
B METERING »
3% VIDEO RESOLUTION B
RETURN SELECT

How to Use the Main Menu in Video Clip Mode:

NOoO A WN =

o<

. Turn the camera on.

. Set the mode switch to ( %8 ) Video Clip mode.

. Press the MENU button to display the main menu.

. Press A or wy until the desired option is highlighted.

. Press p to enter the submenu.

. Press A or ¥y in the submenu to toggle between the options.
. Press the OK button to make a selection.

+ All selections will be marked by a red check mark.

. To return to the previous menu, press « .
. To exit the menu at any time, press the MENU button.
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. Press the Shutter button again to stop recording. Otherwise, the camera will continue to record until the

% PICTURE EFFECT

I BawW
SEPIA

RETURN SET

[4 EV COMPENSAT!

[
H METERING
(1] SPOT

RETURN SET

% VIDEO RESOLUTION

Q& 320x240 IV

Qg 160x120

RETURN SET



TAKING VIDEO CLIPS

Note:

« To understand the differences between the various White Balance settings, refer to p.21.
« To set the different Picture Effects, refer to p.21.

« For more information about Exposure Compensation, refer to p.22.

« For more information about Metering differences, refer to p.24.

SETTING VIDEO CLIP RESOLUTION
Note: 160x120 resolution is ideal for email.

To change the video resolution:

AWN

% VIDEO MODE 38 VIDEO RESOLUTION
TG WHTEBALANGE b
% PICTURE EFFECTS » Qg 160x120
P EVCOMPENSATION )
»
RETURN SELECT RETURN SET

. When Video Resolution is highlighted in the Main Menu, press B to enter the ( &1 ) Resolution submenu.
. Press A or wy repeatedly until the desired setting is highlighted.

. Press the OK button to select the mode

. Press the MENU button to return to video clip mode.
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REVIEWING YOUR FILES

REVIEWING YOUR FILES

REVIEWING THE PICTURES/VIDEO CLIPS
In (=] ) review mode, you can review your stored pictures and video clips through the LCD.

Note: When a memory card is inserted into the camera, only the pictures stored in the memory card will
be displayed in the Review Mode. To view the pictures in the internal memory, ttransfer files from internal
memory to the SD card (refer to p.35). Or turn the camera off, remove the memory card, and then turn the
camera back on.

To review pictures/video clips:

1. Slide the Mode Switch towards ([] ) . The lens will retract in Review Mode.
2. Press « or p repeatedly to scroll through each file.
» The file type and frame counter will be displayed on the LCD.

File Indication File Type 0001/0003
JPEG S AR Number of total pictures /video clips
AVI Video Clip

Number of current picture/video clip

3. When a Video Clip Icon (AVI) is displayed on the LCD, press the OK button to play the video clip.
Note: Press the OK button to pause or resume playing video clip.
To stop playing the video clip, press the Shutter button.
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REVIEWING YOUR FILES

ENLARGING THE PICTURES

In ([»] ) Review Mode, you can enlarge your pictures to take a closer look at the subject on the LCD. This
feature is for viewing purposes only and will not affect the stored image.

2x Enlargement 4x Enlargement
Resolution Maximum Enlargement
2048 x 1536 4x
1600 x 1200 4x
1024 x 768 4x
640 x 480 2x

To enlarge:

1.
2.
3.

4.

In (] ) Review Mode, press « or P repeatedly to scroll through the stored pictures and video clips.
While viewing a stored still picture, press the T button for different magnifications.

Press A ., ¥ , « or p to navigate around the picture. When the picture can pan no farther in one
direction, the directional arrow will disappear.

Press W button to zoom out.

Note: Video Clips cannot be magnified.

29



REVIEWING YOUR FILES

REVIEWING YOUR FILES IN THUMBNAIL

The thumbnail view can be accessed in ([&] ) Review Mode by pressing either Menu or Wide button.

« MENUL0012/0012

fig. 1.2

Using the Quick Access Button:

1. In the (=] ) Review Mode, press W button, nine thumbnail images or video clips will appear on the LCD
display in a few seconds. (fig. 1.2) The first file will be shown first.

2. Press A , ¥ , « or P repeatedly to look through all the pictures and video clips. The selected picture
or video clip will be highlighted by a red border.

3. Press the OK button to view the picture or video clip in full screen.

Using the review menu:
1. In ([»] ) Review Mode, press MENU to enter Review Menu.

2. Press A or ¥ repeatedly to highlight Thumbnail. ] REVIEW

3. Press P> button to have nine thumbnail images or video clips appear at once DELETE FILE
on the LCD display. THUMBNAIL

4. Press A , ¥, « orp repeatedly to look through all the pictures and i sLIDE sHow
video c|ips' -0 FILE TRANSFER

O ROTATE
RETURN SELECT

5. Press the OK button to view the picture or video clip in full screen. Or press
MENU button to return to the previous screen.

USING THE DELETE BUTTON TO DELETE YOUR FILES
You can delete your files in Quick View, Thumbnail or in Review Mode by using the Delete button.

Note: Once a file is deleted, it cannot be recovered.

i Are You Sure?

‘ .:" X No ilg'

v Yes |

[k seLect 2,; n

Deleting in Quick View Mode (Camera Mode)
1. Inthe ( ) Camera Mode, after a picture is taken, the LCD will show the picture for a second. If you are not
satisfied with the picture, press the [fj button, the screen will display the message “Are you sure?”
Note: To change the Quick View time, refer to p.42.
. Press A or ¥ to highlight No or Yes.
3. Press the OK button to confirm selection.
» If Yes is selected, the picture will be deleted.
+ If No is selected, the picture will be saved.

N
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REVIEWING YOUR FILES

Deleting in Review Mode
Delete One
1. In (=] ) Review Mode, press fl button once, the screen will display the message “Are you sure?”
2. Press A or V¥ to highlight No or Yes.
3. Press the OK button to select.
« If No is selected, no change will be made, and the camera will return to the Review Mode.
« If Yes is selected, the file will be deleted.

Delete All
1. In (3] ) Review Mode, press f button twice, the screen will display the message “Delete All, Are you sure?”
2. Press A or ¥ to highlight No or Yes.
3. Press the OK button to select.
< If No is selected, no change will be made, and the camera will return to the Review Mode.
« If Yes is selected, all the files will be deleted.

Deleting in Thumbnail Review Mode

1. When thumbnail view is displayed (refer to P.30), select the image you want to delete, then press i button,
the LCD shows the image in full screen and asks “Are You Sure?”

2. Press A or V¥ to highlight No or Yes.

3. Press the OK button to confirm selection.
< If No is selected, no change will be made, and the LCD will return to the Thumbnail View Mode.
« If Yes is selected, the selected file will be deleted.
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REVIEWING YOUR FILES

USING THE REVIEW MENU

[ DELETE FILE

i DELETE ONE »

M DELETEALL »

=] REVIEW
RETURN SELECT
I THUMBNAIL
fH SLIDE SHOW
= FILE TRANSFER
{ ROTATE
RETURN SELECT

#H sLIDE sHow
DELAY INTERVAL >
CONTINUOUS REPEAT p-

RETURN SELECT

Transfer all files
from internal memory
to memory card?

SELECT

How to use the Menu in Review mode:

NoOohwN =

© ©

. Turn the camera on.
. Set the Mode Switch to ([>] ) Review Mode.

Press the MENU button to display the Main Menu.

Press A or ¥ repeatedly until the desired option is highlighted.
Press p to enter its submenu.

Press g or wy in the submenu to toggle between the options.
Press the OK button to make a selection.

+ All selections will be marked by a red check mark.

. To exit the menu, press « .
. To exit the menu at any time, press the MENU button.
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Are You Sure?

SELECT

> DELAY INTERVAL

@ 2 SEC v
@ 5 SEC
10 SEC
@& 30 SEC

RETURN SELECT

ONTINUOUS REPEAT

® No

RETURN SELECT




REVIEWING YOUR FILES

DELETING YOUR FILES

Note: Once the files are deleted, they cannot be recovered.
Deleting One File by Using the Review Menu
[{l DELETE FILE

[l DELETE ONE
M DELETEALL

| Ae You Sure?

v Yes

e
@;ELEM 1 ‘

RETURN SELECT DELETE

1. In ([*]) Review Mode, press the MENU button to enter Review Menu.
2. Press A or ¥ to highlight Delete File.
3. Press p to enter its submenu.
4. Press A ory to highlight Delete One, then press OK. This LCD shows the images/video clips in thumbnail.
5. Press« or p to highlight the file you want to delete.
6. Press OK button. The next screen will read “Are You Sure?”
7. Press A orV¥ to highlight No or Yes.
8. Press the OK button to confirm selection.
« If No is selected, no change will be made, and the camera will return to the Thumbnail View Mode.
+ If Yes is selected, the selected file will be deleted, and the LCD return to the Thumbnail View Mode.
Deleting All Files
[ DELETE FILE
[_DELETE ONE > Are You Sure?
« Yes
RETURN SELECT SELECT
1. In ([*] ) Review Mode, press MENU to enter Review Menu.
2. Press g or y to highlight Delete File.
3. Press p to enter its submenu.
4. Press A or ¥ to highlight Delete All.
5. Press OK . The next screen will display the message “Are You Sure?”
6. Press A or ¥ to highlight No or Yes.
7. Press the OK button to confirm selection.

+ If No is selected, no change will be made, and the LCD will return to the previous screen.
+ If Yes is selected, all files will be deleted. The LCD will show “No Files!”
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TROUBLESHOOTING

RUNNING A SLIDE SHOW

Use the Slide Show feature to automatically display your pictures and videos on the camera LCD screen at a
selectable interval rate. You can also run a Slide Show on any video device that is equipped with a video input,
such as a television or digital projector.

The Slide Show feature is available when you have at least one picture stored.

] REVIEW F sLIDE sHow

T DELETE FILE B START SLIDE SHOW D>
231 THUMBNAIL ¢ DELAY INTERVAL >

 SLIDE sHow

-0 FILE TRANSFER
QO ROTATE
RETURN SELECT RETURN SELECT

To run a slide show:

1. In (=] ) Review Mode, press MENU to enter Review Menu.

2. Press A or ¥y repeatedly to select and highlight Slide Show..

3. Press p. to enter its submenu.

4. Press p when Start Slide Show is highlighted to begin the Slide Show.
* Pictures: Each picture will be shown for 2 seconds. To change the display interval, refer to the instructions

below.

« Video clips: Only the first frame of the video clip will be shown.

. Press A or ¥ once to speed up or slow down the Slide Show.

. Press 4 or p to skip to the previous or next image.

. Press OK to pause or resume Slide Show.

. To quit the Slide Show, press the Menu button.

0N,

Note: When an SD memory card is inserted into the camera, only the pictures stored in the memory card
will be displayed. To view the pictures in the internal memory, transfer the files onto the SD card or remove
the SD card(p.35).
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REVIEWING YOUR FILES

To set the slide show time interval:
The default slide show interval is 2 seconds. You may change the time following the steps below:

F sLIDE sHow
START SLIDE SHOW  p»

¢ DELAY INTERVAL »

CONTINUOUS REPEAT p-

] REVIEW

T DELETE FILE
THUMBNAIL

=0 FILE TRANSFER

¢ DELAY INTERVAL
@ 5 SEC
@ 10 SEC
@ 30 SEC

>
>
4 SLIDE SHow »
>
>

O ROTATE
RETURN

SELECT RETURN SELECT RETURN SELECT

. In (] ) Review Mode, press MENU to enter Review Menu.

. Press A or ¥ repeatedly to select and highlight Slide Show.

. Press p to enter its submenu.

. Press A or ¥ to highlight Delay Interval.

. Press p to enter the submenu.

. Press A or V¥ to select the length of time for each picture to be displayed on the LCD: 2, 5, 10 or 30

seconds.

. Press OK to select.
. Press 4 to return to the previous menu. Or press MENU to exit.

To repeat a slide show
By default, the Slide Show will stop automatically when the last frame is played. However, you can set the
camera to play the Slide Show repeatedly by following the steps below:

ok whN =

N

£ SLIDE SHOW

#] START SLIDE SHOW
DELAY INTERVAL »
CONTINUOUS REPEAT P>

[®] REVIEW

T DELETEFILE
31 THUMBNAIL

ONTINUOUS REPEAT

£ SLIDE sHow

=0 FILE TRANSFER
{ ROTATE
RETURN

SELECT RETURN SELECT RETURN SELECT

In (=] ) Review Mode, press MENU to enter Review Menu.

Press A or ¥ repeatedly to select and highlight Slide Show.

Press B to enter its submenu.

Press A or V¥ repeatedly to select and highlight Continuous Repeat.

Press p to enter the submenu.

Press A or ¥ to select Yes or No.

« If Yes is selected, the camera will play the Slide Show repeatedly after you started playing a Slide Show.
Press OK to select.

Press « to return to the previous menu. Or press MENU to exit.

TRANSFERRING FILES FROM INTERNAL MEMORY TO SD CARD
The camera can transfer photos and video clips that are stored in the camera’s internal memory to an SD
memory card.

] REVIEW

[ DELETEFILE
i1 THUMBNAIL
£ SLIDE SHOW
QO ROTATE

RETURN SELECT

- [F 2004:03:30
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to memory card?

« Yes

SELECT



REVIEWING YOUR FILES

N

. In (] ) Review Mode, press MENU to enter Review Menu.

2. Press A or V¥ repeatedly to select and highlight File Transfer.

3. Press B . The next screen will display the message “Transfer all files from internal memory to memory

card"?

4. Press A or V¥ to highlight No or Yes.

5. Press OK to confirm selection.

+ If No is selected, no change will be made, and the LCD will return to the TRANSFERRING FILES.
previous screen.

« If Yes is selected, the screen will display “Transferring ...” and all files will
be transferred to the SD card.

Note:

1. Please insert a memory card that has 6 MB or more of available memory. If the SD card does not have
sufficient memory to store all the files from the internal memory, the camera will retain the remaining
images/video clips in the internal memory and will display the message “Memory Full” as well as the
memory card locked icon ( & ).

2. If the SD card is locked, the camera will show memory card locked icon ( & ) for about 2 seconds and
resume to the Main Menu.

3. If no SD card is inserted in the camera, the LCD shows “No card” for a few seconds, then return to
Review menu.

ROTATING THE IMAGES
Stored images can be rotated by 90 degrees clockwise (CW) or counter-clockwise (CCW); the newly-rotated
images can then be saved and replace the originally stored images.

] REVIEW

[ DELETEFILE
i1 THUMBNAIL

£ sLIDE sHow
-0 FILE TRANSFER
QO ROTATE
RETURN SELECT

. In (2] ) Review Mode, press A or ¥ repeatedly to select the desired image to be rotated.

. Press MENU to enter Review Menu.

. Press A or ¥ to select and highlight “Rotate”.

. Press p . The selected image will be shown in full size on the LCD display.
The rotate icon “ + *“ (to rotate clock wise) and “ ~ “ (to rotate counter
clock wise) will also appear on the LCD.

5. Press « or p to repeatedly rotate the image 90 degrees clockwise or

counter-clockwise.

6. Press OK to confirm the selection. The LCD will ask “Save?”

7. Press A or ¥ to highlight “Yes” or “No”, and then press OK to confirm.

« If No is selected, no change will be made. The LCD will restore the
original image.

+ If Yes is selected, the image will be rotated and saved over the original file. The LCD will show “Saving ...”
first, and then show the rotated image.

A WN =
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CUSTOMIZING THE CAMERA SETTINGS

CUSTOMIZING THE CAMERA SETTINGS

CAMERA MODE

ETUP

RETURN SELECT

SETAUTOOFFTIME B

TV OPTION »
@< LANGUAGE OPTION »
& RESTORE DEFAULT >
Xt LCD BRIGHTNESS >

RETURN SELECT
[X3] seTuP
FORMAT »
1, DATE/TIME SETUP »>
DIGITAL ZOOM »
< BEEP >
<€) QuICK VIEW »
RETURN SELECT
SETUP
AFASSISTLIGHT
§ CAMERAINFO. »>
RETURN SELECT

RETURN
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SET AUTO OFF TIME

@) 2MIN v
@ 3MIN

RETURN SET

= TV OPTION
[Bl PAL
RETURN

LANGUAGE OPTION

= DEUTSCH

LI FRANCAIS

] EsPANOL

W ITALIANO
RETURN SET

@< LANGUAGE OPTION

B 3
Lol A#sE
[l PORTUGUES

RETURN

3 RESTORE DEFAULT

« YES
® NO

RETURN SET

(1
Xt LCD BR\GHTNES§

Formatting will erase
all data.

Continue?

®No




CUSTOMIZING THE CAMERA SETTINGS

4, DATEITIME SETUP
[F] - 01 - 2004
01:01AM
MM - DD - YYYY
12- HOUR

RETURN O] SET

DIGITAL ZOOM
® NO
SETUP
TV OPTION
@ LANGUAGE OPTION ~ p RETURN SET
& RESTORE DEFAULT B
X% LCD BRIGHTNESS > <¢ BEEP
RETURN SELECT
< OFF
[X3] seTuP
FORMAT > RETURN SET
CAMERA MODE A DATE/TIME SETUP »>
14 seTuP » DIGITAL ZOOM »
< BEEP S B QUICK VIEW
) QUICK VIEW » %) OFF
RETURN < - seLecr
& 3SEC
RETURN SELECT @ 5SEC
RETURN SET
-
§ CAMERAINFO. > 57 AF ASSIST LIGHT
X) OFF
RETURN SELECT

RETURN SET

i CAMERA INFO.
MODEL:
FW VERSION:
FW PART NO.:
DATE:
CONFIG.:
RETURN

i CAMERA INFO.

To use the Setup menu: LCD PN

1. Turn the camera on. SENSOR P/N:
2. Set the mode switch to ( ) Camera Mode or ([»] ) Review Mode.

3. Press the MENU button to display the main menu.

4. Press A or ¥ repeatedly until Setup is highlighted. RETURN
5. Press p to enter the Setup submenu.

6. In the Setup menu, press A or ¥ repeatedly to highlight the option you wish to

customize.
. Press p to enter the submenu of the highlighted option.
. Use the arrow buttons to adjust the setting and press the OK button to select.
9. Press « to return to the previous menu OR press the MENU button to exit.
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CUSTOMIZING THE CAMERA SETTINGS

SETUP MENU AND FEATURES

Setup Setting Options Description
Set Auto Off Time 2 min, 3 min Enables the camera to automatically power off
when it is idle.
TV Broadcast NTSC, PAL Sets the mode that the camera needs to adapt to your TV.
Standards (Page 59)
Language Option English Sets the language for display on your camera’s LCD. (Page 40)
Deutsch
Frangais
Espariol
Italiano
Nederlands
HAGE
Portugués
Restore Default Yes/No Restores all camera settings to the factory default. (Page 44)
LCD Brightness Sets the LCD brightness level. (Page 40)
Format Yes/No Formats the memory card, which will delete all files.(Page 41)
Date/Time Setup Date/Time, Changes the date/time in your camera and their display
Date/Time format format.
Digital Zoom Yes Activates or deactivates the digital zoom.
No
Beep On, Off Activates or deactivates the beep.
Quick View Off, 1 sec., 3 sec., 5 sec.| Sets Quick View Time interval.
AF Assist Light Auto, Off
Camera Info Model Displays the camera version information. This is for
FW Version information purposes only.
FW Part No.
Date
Config.
LCD P/N
Sensor P/N

SETTING THE AUTO-OFF TIME

A WN =

CAMERA MODE

RETURN

[ X

SETUP
@ SETAUTOOFFTIME b

TV OPTION »
LANGUAGE OPTION

(@ SETAUTO OFF TIME

@ 3MIN

&} RESTORE DEFAULT b
% LCD BRIGHTNESS »

SELECT

RETURN

SELECT RETURN SET

. In the Setup Menu, press A or ¥ repeatedly until Set Auto Off Time is highlighted.
. Press p to enter the submenu.

. Press A or ¥ to highlight the preferred choice.
. Press the OK button to set.

Notes: The default setting is 2 minutes. Press and hold the Power button for more than 1 second to
reactivate the camera after it automatically turns off.
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CUSTOMIZING THE CAMERA SETTINGS

SETTING THE LANGUAGE

[[3] seTuP @ LANGUAGE OPTION @ LANGUAGE OPTION
SETAUTO OFF TIME ) < ENGLISH v = NEDERLANDS
TV OPTION » == DEUTSCH [ 3z
LANGUAGE OPTION  p» B NFRANGAIS Celaxz
f1 RESTOREDEFAULT b [ ESPAROL [l PORTUGUES

¥ LCD BRIGHTNESS > [ W ITALIANO
RETURN SELECT RETURN SET RETURN SET

To set the Language:

1. In the Setup menu, press A or ¥ repeatedly until Language option is highlighted.
2. Press p to enter the Language option submenu.

3. Press A or V¥ repeatedly to highlight the desired language.

4. Press the OK button to set.

SETTING THE DATE AND TIME

SETUP 4, DATEITIME SETUP
[i] - 01 - 2004
01:01AM
MM - DD - YYYY
< BEEP 12 - HOUR

| auick VIEW
RETURN SELECT

RETURN SET

. In the Setup Menu, press A or ¥ repeatedly until Date/Time Setup is highlighted.

. Press p to enter the submemu.

. Press p to highlight the Date/Time fields and Date/Time format. The selected segment will blink.

. Press A or ¥ repeatedly to change the number in the blinking position, press p to go to the new field.
. After the Date/Time is set, press the OK button to quit Date/Time setting.

O wWN =

SETTING THE LCD BRIGHTNESS

CAMERA MODE

(13l sETUP

D SETAUTO OFF TIME
TV OPTION

>
>
@ LANGUAGE OPTION ~ p»
&4 RESTORE DEFAULT  p

Xf- LCD BRIGHTNESS »

RETURN SELECT RETURN SELECT

To set the LCD Brightness:

1. In the Setup Menu, press A or ¥ repeatedly until LCD Brightness is highlighted.
2. Press P to display the LCD Brightness bar on the LCD.

3. Press « or p to adjust the brightness.

4. Press the OK button to set.
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CUSTOMIZING THE CAMERA SETTINGS
FORMATTING THE INTERNAL MEMORY OR MEMORY CARD

CAUTION: ! 1. Formatting will delete all pictures and video clips from the memory.
2. During the formatting process, NEVER REMOVE the memory card nor batteries, as it will

damage the card and/or the camera.
3. When a memory card is not inserted into the camera, selecting the formatting function
will format the internal memory instead. All pictures and video clips stored in the internal
memory will be deleted.

SETUP i3 FORMAT
i FORMAT
50 DATE/TIME SETUP

DIGITAL ZOOM
< BEEP
€ QuICK VIEW
RETURN SELECT RETURN SET

. In the Setup Menu, press A or ¥ until Format is highlighted.
. Press p to enter the Format submenu.
. Press A or ¥ to highlight No or Yes.

. Press the OK button to set.
+ If No is selected, no change will be made, and the LCD will return to the previous screen.
+ If Yes is selected, the LCD shows “Formatting will erase all data. Continue?” (This will delete all files!)

AN

Formatting will erase
all data.
Continue? Formatting ..

@ No 8

. Press A or w to highlight No or Yes.

. Press the OK button to set.
+ If No is selected, no change will be made, and the LCD will return to the Setup Menu.
» If Yes is selected, the LCD will display “Formatting ...”, a process that deletes all files.

[e20e)]

Note: If “Card Error” is displayed on the LCD screen, it indicates that the memory card is corrupted. Format
the memory immediately.
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CUSTOMIZING THE CAMERA SETTINGS

TURNING THE BEEP ON OR OFF

The camera provides an option to enable or disable the beep. By default, the beep is turned ON. The camera
beeps in any of the following situations:

« When the camera is powered on.

« After an image is captured. (For this situation, the camera will beep, regardless of the beep setting.)

« When any button is pressed, except the Power Button, the Mode Slide Button and the Zoom Buttons.

(X3 seTUP

i3 FORMAT
50 DATE/TIME SETUP

DIGITAL ZOOM
BEEP

B QUICK VIEW
RETURN SELECT RETURN SET

To activate/deactivate the beep:

. In the Setup Menu, press A or ¥ repeatedly until Beep is highlighted.
. Press p to enter its submenu.

. Press A or ¥ to highlight the desired selection.

. Press the OK button to set.

AWN o

SETTING QUICK VIEW TIME INTERVAL

The camera provides programmable Quick View duration, which is the duration of time for an image to be
displayed immediately after a picture is taken.

Quick View Description

Off No quick view, LCD continues to show live view.

1 sec (Default) Displays the image for 1 second then resumes to live view.
3 sec Displays the image for 3 seconds then resumes to live view.
5 sec Displays the image for 5 seconds then resumes to live view.

How to select Quick View time phrase:

[3) seTuP € QUICK VIEW

31 FORMAT > X off
J, DATEMIME SETUP >
DIGITAL ZOOM » @3sec
< BEEP » @5 Sec
RETURN SELECT RETURN SET

. In the Setup menu, press A or ¥ until Quick View is highlighted.
. Press p to enter its submenu.

. Press A or y to highlight the desired selection.

. Press the OK button to set.

AN
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CUSTOMIZING THE CAMERA SETTINGS

SETTING AF ASSIST LIGHT

In low-lighting environment, the camera will turn on the built-in AF (Auto Focus) Assist Light to illuminate the
subject that is being focused on.

AF Assist Light

Description

Auto (Default)

The camera will turn on AF assist light if it is needed.

Off

The camera will not turn on the AF assist light even if the subject is in a low-light
condition.

How to change AF assist light setting:

bl

H SETUP //4 AF ASSIST LIGHT
T ”
i Camera Info. » (X) OFF

RETURN SELECT RETURN SET

In the Setup menu, press A or ¥ until AF Assist Light is highlighted.
Press p to enter its submenu.

Press A or ¥ to highlight the desired selection.

Press the OK button to set.
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RESTORE THE CAMERA TO FACTORY DEFAULT SETTINGS

RESTORING FACTORY DEFAULT SETTINGS

To restore the default settings in your camera:
1. In the Setup Menu, press A or ¥ until Restore Default is highlighted.
2. Press A or V¥ to highlight No or Yes, and then press OK to confirm.
+ If No is selected, no change is made. The LCD returns to the previous screen.
« If Yes is selected, the LCD shows “Are you sure?”
3. Press A or ¥ to highlight Yes or No, then press OK.
+ If No is selected, no change will be made. The LCD returns Setup page.
« If Yes is selected, the camera will be reset to the factory default setting. The LCD will show “Restoring....
and then return to setup page. The Default settings will be restored.

The table below lists the default settings:

OPTION DEFAULT STATUS

Camera Mode Single Shot

Image Size 2048 x 1536

Quality Normal

Flash Auto Flash

White Balance AWB

LCD Brightness Center (0)

Scene Selection OFF

Digital Zoom Yes

Exposure Compensation 0

ISO Auto

Metering Matrix

Photo Effect None

Time Out 2 Min

Slide show interval 2 Seconds

Beep On

Quick View 1 Sec

AF Mode Multi-Area

Continuous Repeat Off

AF Assist Light Auto

TV Mode NTSC for USA/Japan, PAL for Europe/Asia

Date/Time Format USA/Japan: MM/DD/YYYY, 12-hour
Europe/Asia: DD/MM/YYYY, 24-hour
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SOFTWARE INSTALLATION GUIDE

SOFTWARE INSTALLATION GUIDE

The software that comes with your 3 Megapixel Digital Camera includes driver, reader, and photo editing
programs. These programs transfer the pictures or video clips from your camera to your computer, and enable
you to view them on your computer monitor. Refer to the following list of computer system requirements for
installation of the programs.

Computer System Requirements

Windows

« 300MHz Pentium Il processor or equivalent.

« Microsoft Windows 98/98SE, Windows Me, Windows 2000 Professional, Windows XP Home / Professional /
Media Center

* 360MB free hard disk space .

« 128MB of RAM

«  Minimum 800 x 600 display with 16-bit color (1024 x 768 with 24-bit color or better is recommended)

* USB Port

« 4x CD-ROM Drive

Macintosh

*« Mac 0S8 9.0,9.1,9.2 and X 10.1 or later

« Power PC-based

« 32MB of RAM

« 640 x 480 display with Thousands of colors (Millions of colors recommended)
« Built-In USB Port

Installation Requirements
The installer will automatically detect which software applications need to be installed or if they are not
necessary. Please read the installation requirements before proceeding with the installation process.

System Windows Windows Windows Windows Macintosh
98/98SE Me 2000 XP

Install Camera Driver X

Install DirectX 9 X

Install ArcSoft Photolmpression X X X X

Install Adobe Acrobat

Reader 5

Camera automatically detected X X X X

by the computer (no driver
installation required)
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SOFTWARE INSTALLATION GUIDE

USING THE INSTALLER SPLASH SCREEN

The installer will automatically detect which software applications need 5
to be installed or if they are not necessary. This will be indicated by = 1 eloome to the

Jenoptik JD € 3.1 23 Setup

the buttons on the splash screen that appears when the CD-ROM is

inserted into the computer:

Color Description

Yellow ( ) | Required or highly recommended to install.

Gray ( ® ) Already installed or not necessary to install.

Option

Description

Camera Drivers

The USB Mass Storage camera drivers enable the camera to become
an external drive on your computer.

Microsoft DirectX 9

DirectX 9 enables the movie playback applications on your computer to
playback video clips that are captured with the camera.

ArcSoft Photolmpression 2000

This photo software enables you to edit and enhance pictures.

Adobe Acrobat Reader 5

Adobe Acrobat Reader enables you to view the electronic version of the
User’s Guide.

User’s Guide

Direct link to our camera support website. Ensure that an internet
connection is established before clicking on the link.
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SOFTWARE INSTALLATION GUIDE

FLOW DIAGRAM FOR SOFTWARE INSTALLATION

To transfer the pictures and video clips from the memory, the camera must be connected to a computer with the
provided Mini-USB cable. Additional setup may be required by some operating systems before connecting the

camera to the computer for the first time.

Identifying your operating system

Windows
Me/XP

Mac OS
9.x/10.x

and DirectX 9 p.49

Windows Windows 2000
98/98SE Professional
Installing the USB Installing
Mass Storage Drivers DirectX 9 p.51

!

|

Installing ArcSoft Photolmpression 2000 p.52

!

Installing Adobe Acrobat Reader 5 (if needed) p.54

!

{

Connecting the camera to the computer p.56

!

!

Downloading pictures and video clips onto the computer p.56

!

!

Disconnecting the camera from the computer p.58

Data transfer may not function correctly if you have one of the operating systems listed below or you are using

an add-on USB adapter or USB hub.

*  Windows 95

»  Windows NT 3.51/4.0
* Mac OS 8.6 or lower.
* Home-built computer systems or computer systems without a factory installed operating system.
» Home-installed operating system or upgrade to the operating system.
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SOFTWARE INSTALLATION GUIDE

IDENTIFYING YOUR OPERATING SYSTEM e =
Windows ‘ n
1. Right click the My Computer icon on your desktop, and go to Properties. —

2. The System Properties Box will appear.(fig.1.1)
The information about your computer is listed under the system area.

3. Confirm that your computer is running one of the following operating systems and
proceed to the page in the chart for installation instructions:

G
[

A coupnres
Tnsrs

i = |
System Proceed to page
Windows 98, Windows 98 Page 49
Second Edition
Windows 2000 Page 51
Windows Millennium Edition, Page 52
Windows XP Home Edition,
Windows XP Professional Edition,
Windows XP Media Center Edition

4. Press OK to close the window

For Windows 98/98SE/Me/2000, if the My Computer icon is not on your desktop, click Start > Settings >
Control Panel to display the Control Panel window (fig. 1.2). Double click on  System icon to open the
System Properties Box (fig. 1.2).

For Windows XP, if the My Computer icon is not on your desktop, click Start > Control Panel >
Performance and Maintenance, then click on the System icon to open the System Properties Box (fig.1.1).

Macintosh

1. In the Apple Menu on the Menu bar, select About this Computer.

2. Awindow will appear with the computer’s operating system version. Confirm that your computer is version 9
or higher.

No installation of software is necessary for Macintosh users, please go to Page 56 for connecting your camera
to the computer.
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SOFTWARE INSTALLATION GUIDE

INSTALLING THE DRIVER AND DIRECTX 9 — WINDOWS 98/98SE

Do not connect the camera to your computer BEFORE the camera drivers and Microsoft DirectX 9
installation is completed.

Step 1

Make sure your camera is powered off and not connected to the computer.

Step 2

Make sure the computer is powered on and Windows 98 or 98SE is running.

Step 3

Close any other applications or software you may be running.

Step 4

Insert the supplied CD-ROM into your computer’'s CD-ROM Drive.

NOTE: If the installer does not start automatically within 30 seconds after the CD-ROM has
been inserted, click on “My Computer” either on the Desktop or in the Start Menu and locate
the CD-ROM Drive. Double click on the CD-ROM Dirive icon for installation and proceed to
Step 5.

Step 5

Select the language. Click [OK].

Step 6

The installation screen will appear. Click on Install
Camera Drivers.

Welcome to th
Jenoptik JD € 3.1 23 Setup

Step 7

Click [Next >].

Step 8

The next dialog will prompt you to select the components
that will be installed. USB Mass Storage Driver and
DirectX 9 will be pre-selected.

The files will be saved in the Camera directory
automatically.

OR e e
You may change the default folder by clicking [Browse...] A e —
and selecting a different folder in your computer.

Click [Next >].

e
e — (|

O e
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SOFTWARE INSTALLATION GUIDE

Step 9 Click [Install].
Step 10 Install progress bar e
—
Step 11 The next screen will begin the DirectX setup.
Select “ | accept the agreement “ then click [Next >].
Step 12 Click [Next >].
Step 13 Click [Finish].

Your computer will automatically restart.

| e
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SOFTWARE INSTALLATION GUIDE

INSTALLING DIRECTX 9 — WINDOWS 2000

Step 1 Make sure your camera is powered off and not connected to the computer.
Step 2 Make sure the computer is powered on and Windows 2000 is running.
Step 3 Close any other applications or software you may be running.

Step 4 Insert the supplied CD-ROM into your computer’'s CD-ROM Drive.

NOTE: If the installer does not start automatically within 30 seconds after the CD-ROM has
been inserted, click on “My Computer” either on the Desktop or in the Start Menu and locate
the CD-ROM Drive. Double click on the CD-ROM Dirive icon for installation and proceed to

Step 5.
Step 5 Select the language. Click [OK]. L ELE]
Step 6 The installation screen will appear, click on Install

Microsoft DirectX 9.0.

Welcome to the
Jenoptik JD € 3.1 23 Setup

2 Install ArcSoft@ Photalmpression™ 2000
3 Install Adobo Acrobat® Readore 5

2 Viow Usor's Guide

2 Vil Concord Suppart Web Site

Step 7 The next screen will begin the DirectX setup.
Select “ | accept the agreement “ then click [Next >].

[FoRickTsr <0,

Step 8 Click [Next >]. it s

ot i e ek ot

Lo [CWT oot

Step 9 Click [Finish].
Your computer will automatically restart.
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SOFTWARE INSTALLATION GUIDE

INSTALLING ARCSOFT PHOTOIMPRESSION — ALL WINDOWS USERS

Step 1 Make sure your camera is powered off and not connected to the computer.
Step 2 Make sure the computer is powered on and Windows is running.
Step 3 Close any other applications or software you may be running.
Step 4 Insert the supplied CD-ROM into your computer’'s CD-ROM Drive.
NOTE: If the installer does not start automatically within 30 seconds after the CD-ROM has
been inserted, click on “My Computer” either on the Desktop or in the Start Menu and locate
the CD-ROM Drive. Double click on the CD-ROM Dirive icon for installation and proceed to
Step 5.
Step 5 Select the language. Click [OK].
Step 6 The installation screen will appear, Click on Install
ArcSoft Photolmpression 2000. erome e
Jonoptik J ¢ 5.1 73 Setup
Step 7 Click [Next >].
ot
Step 8 Click [Yes].

P st g oarss s

o M ArcSoft

P hsPAGE DO oy o s et f o sosrort.
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SOFTWARE INSTALLATION GUIDE

Step 9 Click [Next >]. e,
ettt e S i fA;c§ ot
[ — =
Step 10 Make sure the two applications are checked and then
click [Next >].
co
Step 11 Click [Next >].
e )
Step 12 The screen will show the status of the installation. S
A ArcSoft
R
1 1%
T
Step 13 Click [Finish].

Installhisd Wizard Complete

Win98 will request for restart.

L T ——
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SOFTWARE INSTALLATION GUIDE

INSTALLING ADOBE ACROBAT READER 5- ALL WINDOWS USERS (OPTIONAL)

Step 1 Make sure your camera is powered off and not connected to the computer.
Step 2 Make sure the computer is powered on and Windows is running.
Step 3 Close any other applications or software you may be running.
Step 4 Insert the supplied CD-ROM into your computer’s CD-ROM Drive.
NOTE: If the installer does not start automatically within 30 seconds after the CD-ROM has
been inserted, click on “My Computer” either on the Desktop or in the Start Menu and locate
the CD-ROM Dirive. Double click on the CD-ROM Dirive icon for installation and proceed to
Step 5.
Step 5 Select the language. Click [OK].
Step 6 The installation screen will appear, Click on Install
Adobe Acrobat Reader 5. o S et
Step 7 Status bar
Unpacking ADMPlugin apl
¢ anmEEEREERREEEREEE
“Cancel I
Step 8 Click [Next >].

N =
D S —
P i a1 s ongete

1 oy o ot o st i e
[

ik Cance o i St e henclose ery s ou

Peveming Cick e o coie wihire Saup pegon.
VARRING, This g s poeted by copiah o e

3 el e

et o crdnn of o .
gty e ordcmioeates 4
i

Pt

Hotr | coeal
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SOFTWARE INSTALLATION GUIDE

Step 9 The files will be saved into C:\Program Files\Adobe\
Acrobat 5 automatically. S
OR R —
[ —
You may change the default folder by clicking [Browse...]
and selecting a different folder in your computer.
Click [Next >]. ——
Step 10 Installation progress Copying program fles
o \program files\adobehacrobat 5.0'eader\ acrord32 ke
. v
Step 11 Select Yes, to restart the computer or No, to restart the
computer later. o ‘
Click [Finish >]. |
|
L ‘
it i e
|
|
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CONNECTING THE CAMERA TO THE COMPUTER

CONNECTING THE CAMERA TO THE COMPUTER

Windows 98/98SE users - Do not connect the camera to your computer BEFORE the camera
drivers and Microsoft DirectX 9 installation is completed.

-

. Power the camera on.
2. Connect the camera to the computer with the Mini-USB cable provided.

» Plug the larger end of the Mini-USB cable that is included with the camera into
your PC’s USB port. (Please refer to your computer’s documentation for more
information on the location of the USB port.)

» Plug the small end of the Mini-USB cable into the USB port located in the Cable
Connection panel on the side of the camera.

3. When the camera is connected to the computer for the first time, the camera
USB Mass Storage driver installation will begin. Please follow the on-screen instructions to complete the
installation.

DOWNLOADING PICTURES AND VIDEO CLIPS ONTO YOUR COMPUTER

Note: Windows 98/98SE users must install the Camera Driver and DirectX 9 first. (Page 49)

Note: Windows 2000 users must install DirectX 9 to view video clips on the computer. (Page 51)

Downloading files from the camera:
* Insert the memory card.

Caution: Do not attempt to open the battery/memory door to insert or remove the memory and/or batteries
when the camera is connected to the computer.

FOR WINDOWS USERS
Downloading Pictures and Video Clips onto your computer:
. Connect the camera to the computer.
. Double-click on My Computer.
. Double-click Removable Disk.
. Double-click DCIM.
. Double-click the folder that contains the desired images to view.
* The pictures (JPEG) and video clips (AVI) stored in the memory will be displayed.
. Click and drag the files into a directory in your computer to save them.
+ To select all files, click Edit > Select all.

O WN =

(2]

FOR MACINTOSH USERS
1. Connect the camera to the computer.
» After a few moments, the external hard drive will appear on the desktop.
2. Double-click the “JD C 3.1z3” removable drive that is on your desktop.
3. Double-click DCIM.
4. Double-click the folder that contains the desired images to view.
+ The stored pictures (JPEG) and video clips (AVI) stored in the memory will be displayed.
5. Drag and drop the image you want to save in the computer.
» To select all files, click Edit > Select all.

Note: You may also transfer the stored pictures and video clips onto your computer by using a memory
card reader (sold separately.)

56



CONNECTING THE CAMERA TO THE COMPUTER
USING ARCSOFT PHOTOIMPRESSION (WINDOWS ONLY)

1. Connect the camera to the computer.
2. Launch ArcSoft Photolmpression software by clicking on Start-Programs-ArcSoft Camera Suite and choosing
Photolmpression from the application list on your screen. (fig. 1.1)

fig. 1.1 fig. 1.2

3. When the Application opens, click on the Camera/Scanner button.(fig. 1.2)
4. Click on the drop-down list under Select Source and choose JD C 3.1z3 Camera.
5. Click on the Camera/ Scanner Icon ( ).
« A second window will appear showing the contents (pictures) in the memory, and options on how to
handle them. (fig. 1.3)

fig. 1.3

6. Select the desired picture to view, edit or save by clicking on it. The selected image will be highlighted by a
border. To choose all pictures, click on Select All.

7. Click on Get Photos.
The pictures will then be added to your album at the bottom of the application (fig. 1.4).

fig. 1.4

8. Click on Close to close the Camera Controls windows (as shown in
fig. 1.3).

9. Double-click on the thumbnail or click on OK to open the photo.

10. Click on Edit to edit the photo. You may, for example,
* Resize the photo by using the “Crop/Resize” tools.
« Modify the photo by using the “Retouch” tools. For example, to remove red-eyes.
+ Add some text onto the photo by using the “Text” tools.

11. Click on Save to save the photo. Two options are available: “Save” and “Save As”.

12.Click on Print to print the photo. The options available include: Standard Printing, Greeting Card/Multiple
Printing or Thumbnail Printing.

57



CONNECTING THE CAMERA TO THE COMPUTER

UNPLUGGING YOUR CAMERA FROM THE COMPUTER

Windows ME/2000/XP:
Click once on the “Unplug or Eject Hardware” icon on the right hand side of your task bar.

1.

2.

3.
4. Unplug the Mini-USB from the camera. (fig.1.2)

(fig.1.1)
Select “Stop JD C 3.1z3 Camera USB Mass Storage Device”
Click [OK] in the “Safe to Remove Hardware” prompt.

Macintosh:

1.

Drag the “JD C 3.1z3 ” removable drive icon on the desktop to the Trash. Or click
on “JD C 3.1z3 ", then click “Eject” under “File” or “Special” (if the mouse is not
available).

. Unplug the Mini-USB cable from the camera.
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TV MODE

TV MODE

CHANGING THE TV MODE SETTING

The camera allows you to view individual files and to take pictures or record clips on the television. To begin,
check your television documentation to determine the suitable type of TV broadcast standard (TV OPTION):
NTSC or PAL.

[T3] seTup = TV OPTION

(D SETAUTO OFF TIME [Nl NTSC e

B Pl

@ LANGUAGE OPTION
& RESTORE DEFAULT
£ LCD BRIGHTNESS
RETURN SELECT RETURN SET

Slide the Mode switch to ([5] ) Camera Mode

Press the MENU button.

Press A or ¥ repeatedly until Setup is highlighted.

Press p to enter the Setup menu.

In the Setup menu press A or ¥ until TV option is highlighted
Press p to enter the TV submenu.

Press A or ¥ to change the setting to NTSC or PAL and press OK.
Press the MENU button to exit.

ONOOAWN =

CONNECTING THE CAMERA TO THE TELEVISION

1. Connect the red sound terminal of the AV cable to the sound terminal marked AUDIO of your TV, and

connect the yellow image terminal of the AV cable to the image input terminal jack marked VIDEO or VIDEO

IN on your television.

Turn on your television.

3. Set the television to video mode according to the
instructions in the owner’s manual. (This is usually channel
3, 4 or AV).

4. Connect the other end of the cable into the VIDEO port
located in the cable connection panel.

N

USING THE TV AS A LIVE VIEWFINDER

1. Connect the camera to the TV.

2. Turn the camera on.

3. Slide the Mode Switch to ([3] ) Camera Mode.
4. The TV will become a Live Viewfinder.

Note: You may record your TV Mode session by using your VCR. Please refer to your VCR documentation
to learn more about recording.

REVIEWING PICTURES AND VIDEO CLIPS ON YOUR TV

1. Connect the camera to the TV.

2. Turn the camera on.

3. Slide the Mode Switch to ( ) Review mode.

4. Press A ory to scroll through the saved pictures and video clips.
« When an AVI file is displayed on the TV, press the OK button to view the video clip.

5. To view more options, press the MENU button to display the menu on the TV screen. Please refer to
page 32/37 for further information.
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ERROR MESSAGES

ERROR MESSAGES

Error Messages appear on the LCD when the memory is full or when there is a problem with the SD card.

Error Message

Cause

Solution

Memory Full

Memory (either internal memory
or SD card) is full.

Follow one of the below methods:
1) Delete unwanted files.

2) Insert an SD card or replace
the SD card with another that has
free memory space.

3) Transfer the photos/video clips
onto your computer.

Memory Full

The SD card memory isn’t enough
to hold the files saved in the
internal memory. Only part of the
files in the internal memory is
transferred.

Follow one of the below methods:
1) Delete unwanted files.

2) Insert an SD card, or replace
the SD card with a new one.

3) Transfer the photos/video clips
onto your computer.

Memory Error

The camera’s internal memory
may be corrupted.

Format the internal memory (P.41)
first. If the problem remains after
formatting, that means the internal
memory is corrupted. You can
either use an SD card as storage
or send the camera for repairing.

Card Error

The SD card may be corrupted.

Format the SD card first. If

the problem still exists after
formatting, replace the corrupted
SD card with a new one.

Imcompatible Media
Formating will erase
All data Continue?

The memory card is not
recognizable (maybe the card
is new or used on other digital
cameras).

Format the SD card.

The memory card is locked.

Turn off the camera, take out the
SD card and unlock the SD card.

No Card

Attempts to transfer files when an
SD card is not inserted into the
camera.

Insert an SD card with enough
free memory.

Format Error

The internal memory or the SD
card is corrupted.

For an internal memory problem,
use an SD card as storage
instead. For an SD card problem,
replace the SD card with a new
one.
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TROUBLESHOOTING

SYMPTOM

POSSIBLE CAUSE

POSSIBLE SOLUTION

CAMERA

Cannot turn on the camera.

Batteries are not installed
correctly.

Install batteries correctly by
following the indication engraved
on the edge of the battery
compartment or that on the
battery contact.

Batteries are flat or weak.

Replace batteries.

Battery door is not closed
properly.

Close the battery compartment
door properly.

To prevent accidentally powering
on the camera, it is designed to
power on with a set delay.

Press and hold the power button
for more than 1 second to power
on the camera.

In cold weather, battery power
level might temporarily fall,
thereby affecting camera
performance.

Try different ways to warm the
batteries, for instance: place them
in your pocket or warm them with
your hands, before re-trying
operation.

The camera buttons do not work.

The camera needs to be reset.

Press the reset button on the
back of the camera with a pointed
object, such as a pen, then power
the camera off then on.

The camera turns off during
usage.

The batteries are drained of
power.

Replace the batteries with new
ones.

Camera automatically powers
off and retracts the lens after

2 minutes (default setting) of

inactivity.

Press any button to power the
camera on again.In the Setup
menu, set the Auto-OFF Time to
3 minutes (for detail instructions,
see page 39).

The camera cannot turn off the
Auto-Focus setting.

The Camera is designed to have
the Auto-Focus setting.

LCD displays white screen when
powered on.

This can occur when the camera
is repeatedly powered on/off in
quick successions.

Wait for a few seconds between
powering on or off the camera.

PICTURES/VIDEO CLIPS

Picture/Vide clip has poor
image quality.

Poor Lighting.

Increase the lighting in the
surrounding area when taking
pictures and video clips.

Lens is dirty.

Clean the lens with a soft cloth.
Refer to the Safety Tips and
Maintenance section (p. 71).

Subject is too close.

Stand at least 2 ft. (0.6m) away
from the subject in the Normal
Mode. In Macro Mode, keep the
camera and the subject within
the range of 5.9 inch (15cm) to
2ft (60cm).
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SYMPTOM

POSSIBLE CAUSE

POSSIBLE SOLUTION

The images are dark on the
computer and when printing, but
all images look fine in Review
Mode.

Configuration and settings of
computer and printer need to be
adjusted.

The display setting of the
computer can be adjusted via the
Control Panel’s Display section
or the actual display settings of
the monitor.

The printer’s setting can be
adjusted via the Control Panel’'s
Printers.

Refer to the user’s documentation
that comes with the computer
and printer.

TAKING PICTURES

Flash picture taken is too light.

Subject is too close.

Move the subject further away
from the camera.

The flash is not needed.

Change the camera setting to
Auto Flash. See p. 12.

Lighting condition is too bright.

Decrease exposure
compensation. See p.22.

Flash Picture taken is too dark.

The subject is too far away for th
flash to be effective.

Move the subject closer to the
camera, or move the camera
closer to the subject.

Flash is not on.

Select “Auto Flash” or “Flash On”
setting.

The subject is in front of a bright
light.

Change the subject’s position

if possible or move to another
location to take the picture of the
subject from another angle.

Lighting condition is too dark.

Increase the exposure
compensation. See p. 22.

Flash did not work.

There was sufficient lighting for
the picture, so the flash did not
fire. This happens when the
camera is set to Auto Flash.

This is normal, as your camera’s
electronic light sensor is
programmed to only fire the flash
when needed.

Camera’s flash has been turned
off.

Select “Auto Flash” or “Flash On”
setting.

Flash did not charge.

Ensure that the Ready LED has
stopped blinking before taking a
picture.

Selected the Continuous or Sport
mode.

When the Continuous or Sport
mode is selected, the flash is
disabled.

My fresh set of batteries took
only a few pictures and they are
now flat.

Depends on the level of usage.
Auto-Focusing, zooming in and
out are some of the functions that
tend to draw more power.

To save power, turn off the LCD.
When the camera is not in used,
power it off. Economize on

the use of the Auto-Focus and
zooming functions
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SYMPTOM

POSSIBLE CAUSE

POSSIBLE SOLUTION

My fresh set of batteries took
only a few pictures and they are
now flat.

Are the fresh batteries newly
purchased?

So-called fresh batteries that have
been purchased a long time ago
cannot be considered fresh; as
battery power tends to drop over an
extended period of time.

Are the battery contacts dirty?

Every once in a while battery
contacts need to be cleaned. Refer
to the Safety Tips and Maintenance
section (p. 71).

Picture taken is blurry.

Subject or camera moved as the
picture was taken.

1. Hold camera steady until the
picture is taken.

2. Select the Sport capture mode
for fast-action-oriented subjects.

The focus was not locked
beforetaking the picture.

Before taking a picture, press the
Shutter Button halfway to lock the
focus (the green LED besides the
optical viewfinder will remain ON
and the Focus Mark at the center
of display will be green), then press
the Shutter Button fully to capture
the picture. (p.11)

Check that the Marco mode is not
selected.

Use the Marco mode only for
shooting distances between 2.9ft
(15cm) ~ 2ft (60cm). Otherwise, use
the normal capture mode.

The lens is dirty.

Clean the lens with professional
lens cleansing paper or use a piece
of lint-free, soft-dust-free cloth to
gently wipe the lens.

The subject is not located at the
center of the focus mark when
composing the image.

Make sure the subject is centered
in the focus mark when composing
the image.

There is something wrong with
the color of the photographs.

White balance is not set properly.

Reset the white balance setting to
Auto, or for the specific lighting in
the surrounding area.

The white balance is not correctly
adjusted.

Aim the camera at something white
such as a white piece of paper,
press the Shutter button half-way
to adjust the white balance to the
subject’s lighting condition.

Cannot take a picture or record a
video clip.

Memory is full.

Insert a memory card with sufficient
memory available.

Download the stored files to your
PC and delete the files from the
memory card.

Delete unwanted pictures and
continue shooting.
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SYMPTOM

POSSIBLE CAUSE

POSSIBLE SOLUTION

amera is not set in picture/vide:
lip taking mode.

Set the camera to the proper
mode for recording video clips, or
aking photographs.

Power is off.

urn the power on.

amera is in Auto Power off Mode|

urn the power on.

he remaining battery power is lo

Replace the batteries.

amera is connected to a comput

Disconnect the camera from the
computer before taking pictures.

Cannot take a picture or record a
video clip when using an SD
memory card.

he SD card is locked or write-
rotected.

Remove the SD card from the
card slot and slide the lock switch
o off.

he SD card cannot be recognize:

Format the inserted SD card
before using it to take pictures.

Picture is blurred when looking
through the viewfinder.

iewfinder is dirty.

Clean the Viewfinder with a soft
cloth or cotton swab. See the
(Camera maintenance section.

Part of the picture/ video clip is
missing.

omething was blocking the lens
hen taking the picture.

Keep hands, fingers, etc. away
rom the lens when taking a picture.

he picture was not centered
rrectly in the viewfinder.

Leave space around the subject
hen centering the picture in the
viewfinder.

Camera is not responding
during picture capture.

he battery level is low and the
amera does not have sufficient
ower to complete picture capture]

Replace batteries

he camera needs to be reset.

Press the reset button at the back
of the camera with a pointed object,
such as a pen, then power the
camera off then on.

The Shutter button does not
work.

he camera is not turned on.

urn the camera on.

he camera is processing a pictur
he ready LED light is still blinking.

ait until the light stops blinking
before attempting to take another
picture.

Picture taken did not save in
memory.

he camera powered off before
ompleting the save operation.

If the low-battery indicator
appears on display, replace
batteries with a fresh set.

he memory card was removed
efore completing the save
peration.

DO NOT open the battery/
memory card compartment door

hen the camera is powered on,
as it could corrupt the memory
card.

Battery door was opened before
ompleting the save operation.

Ensure that the battery/memory
card compartment door is
properly and securely closed
before taking pictures.
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SYMPTOM

POSSIBLE CAUSE

POSSIBLE SOLUTION

LCD

The LCD display is dark.

Protective plastic film is still in
place on the camera.

Make sure the protective plastic film
covering the LCD (for protection
purposes during shipment) has
been removed.

The LCD brightness level is set
too low or the surrounding lightin
condition is poor.

Increase the brightness level on
your LCD to meet your personal
needs. See p.40 for setting the
brightness.

The LCD is dim or visibility is
poor.

The set LCD brightness level is
too low.

Adjust the brightness in the Setup
mode, see page 40.

When using the camera in sunny
conditions, the visibility of the LC
may seem dim.

Shade the display for better
visibility. .

The LCD screen looks milky
and or scratched.

Protective plastic film is still in
place on the camera.

Make sure the protective plastic film
covering the LCD (for protection
purposes during shipment) has
been removed.

The LCD is not displaying
anything.

LCD is turned off.

Turn the LCD on, by pressing (| )-

The battery level is low.

Replace the batteries.

LCD does not display stored images.

The camera is in the picture
capturing mode.

Set the camera to review mode.

The camera is connected to a
television.

The LCD turns off when the camera
is connected to a television.

VIEWING VIDEO CLIPS ON THE COMPUTER (WINDOWS 98/98SE/2000)

Cannot playback stored video
clips on the computer.

Video playback files are missing.

Install Microsoft DirectX 9. (p.49)

INSTALLING SOFTWARE AND DRIVERS

Camera is not responding
during picture download to the
computer.

The operating system may not be
allocating adequate resources to
download the pictures.

Reset the camera by pressing
the reset button with a pointed
object such as a pen. Reboot the
computer.

The Mini-USB cable is not
plugged into the camera.

Check that the Mini-USB cable is
plugged into the camera.

The Mini-USB cable is not
plugged into the computer.

Check that the USB cable is
plugged into the computer.
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SYMPTOM

POSSIBLE CAUSE

POSSIBLE SOLUTION

Camera is not responding
during picture download to the
computer.

The USB port of computer is
damaged.

Replace or repair the USB port.

The USB cable is damaged.

Replace the USB cable.

Computer cannot detect the newl
installed driver

Update the driver in My Computer
> Properties > Hardware > Device
Manager.

The driver did not install
successfully.

Uninstall and re-install the driver.

The computer is not powered on.

Turn your computer on.

Cannot transfer pictures to the
computer. The New Hardware
Wizard cannot locate drivers.
(Windows 98/98SE)

The Software is not installed on
the computer.

Disconnect the Mini-USB cable
from the camera and the computer.
Install the camera software and
drivers. (p.49)

Software is not fully or correctly
installed on the computer.

Disconnect the Mini-USB cable
from the camera and the computer.
Uninstall the

software: click Start >Setting >
Control Panel > Add/ Remove
Programs. Re-install the camera
drivers. (See p.49)

SD CARDS

The camera does not
recognize your SD Card.

The card may not be SD certified.

Purchase a certified SD card.

The card may be corrupted.
Reformat the card.

Caution: Formatting erases all data
on the card. P.41

No card is inserted in the camera.

Insert a card into the card slot.
See p.8

The card is locked.

Take out the card and unlock.

RECHARGEABLE BATTERIES

A low battery warning appears
during initial use of the freshly
charged batteries.

The batteries might not have been
charged properly.

Recharge the batteries to maximum
capacity (confirm the needed
duration of re-charge time

Camera is not responding
during picture download to the
computer.

The batteries haven’t reached
their maximum capacity.

Fully charge/discharge the batteries
via normal operation for three to
four cycles

The battery contact is dirty.

Clean the battery contacts and
battery polarities with alcohol and a
soft, dust-free, lint-free, clean cloth.

Excessive zooming and powering
on/off operations

Avoid these kinds of unnecessary
operations.
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GETTING HELP

You can get help from our troubleshooting section, FAQ on our website www.concord-camera.com or by
contacting a customer support representative.

Before You E-mail or Call us:
If you have questions concerning the operation of the camera or software installation, you can speak to or e-
mail a customer service representative. Please have the following information available:

Camera Information: Computer Information:
Name of camera model Operating System Processor Speed (MHz)
Camera Serial Number Computer Maker and Model

Exact Error message received Date
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CAMERA SPECIFICATIONS

Lens

Aperture
Shutter
Optical Zoom
Digital Zoom

Focus Range

Focusing System
Image Sensor Type
Sensor Effective Pixels
Image Aspect Ratio
Image Size

Image Quality
Sensitivity (ISO setting)
Capture Mode
Exposure

Auto Exposure metering
White Balance

Scene Selection

Picture Effect

Exposure Compensation
Continuous Shoot

Video Clips

Self-Timer

Storage Type

Internal Storage

7.23 - 21.7mm (equivalent to 38-114 mm in 35mm format),
/2.8 - /4.7, 6 groups 6 elements all glass.

2 steps: f/2.8 and /5.6 at wide zoom position
Electronic, 4s — 1/1000s

3x in 6 steps

3x

Auto Focus from 60cm to infinity (23.6 in. to infinity), macro from 15 cm to 60 cm
(5.9in.t0 23.6 in.)

5 area Multi-area AF, Center Spot AF

1/2” CMOS

3.1 Megapixels

4:3

2048 x 1536, 1600 x 1200, 1024 x 768, 640 x 480
Fine (4.5:1), Normal (11:1), Economy (17:1)

Auto, 100, 200, 400 (user selectable)

Single Shot, Sport, Continuous Shot, Sport + Continuous Shot
Auto

Spot, Matrix

Auto, Sunny, Fluorescent, Tungsten

Off, Party/Indoor, Beach, Snow, Night Landscape, Sunset, Fireworks, Night
portrait.

Off, B&W, Sepia
+/-0,0.3,0.7, 1.0, 1.3, 1.7, 2.0 EV
7 frames in 2.3sec with 640x480 resolution

AVI format,
+ 320x240 or 160x120 resolution with 20 fps, approx 25sec with 8 MB storage.

10s delay with blinking red LED (7s slow blinking and 3s fast blinking), available
for camera and video clip.

Internal Memory and SD card

6 MB Internal Non-Volatile Memory
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Storage Capacity

Images Stored on 6MB memory (approx.):

Image Quality Image Size
3MP 2MP 1.3MP VGA
(2048 x 1536) (1600 x 1200) (1024 x 768) (640 x 480)
Fine (4.5:1) 4 6 14 36
Normal (11:1) 8 13 32 79
Economy (17:1) 15 23 55 130
Images Stored on 16MB memory (approx.):
Image Quality Image Size
3MP 2MP 1.3MP VGA
(2048 x 1536) (1600 x 1200) (1024 x 768) (640 x 480)
Fine (4.5:1) 9 14 33 82
Normal (11:1) 19 31 74 181
Economy (17:1) 34 53 125 297
Images Stored on 32MB memory (approx.):
Image Quality Image Size
3MP 2MP 1.3MP VGA
(2048 x 1536) (1600 x 1200) (1024 x 768) (640 x 480)
Fine (4.5:1) 20 29 68 171
Normal 41 65 154 376
Economy Al 1M1 261 616
Images Stored on 64MB memory (approx.):
Image Quality Image Size
3MP 2MP 1.3MP VGA
(2048 x 1536) (1600 x 1200) (1024 x 768) (640 x 480)
Fine (4.5:1) 42 60 140 351
Normal 84 135 316 77
Economy 146 229 536 1270
Images Stored on 128MB memory (approx.):
Image Quality Image Size
3MP 2MP 1.3MP VGA
(2048 x 1536) (1600 x 1200) (1024 x 768) (640 x 480)
Fine (4.5:1) 83 19 279 698
Normal 167 268 628 1532
Economy 290 455 1064 2512

Output file format

Optical Viewfinder

JPEG compression with EXIF 2.2

Real image zoom finder with 70-90% coverage

LCD 1.5” TFT LCD, 280(H) x 220(V), 61,600 Pixels
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Playback Zoom

Flash Mode

Flash Range

User Interface

Multi Language Support

Mode Selection
Slide Show
AF Assist Light

Speaker
Tripod Socket
Connectivity

System Connectivity

Time Out

Power Source

Dimensions
Weight

Accessories

2x, 4x (for 2048 x 1536, 1600x1200, 1280x960);
2x (for 640x480)

Auto, Auto + RER, Flash ON and Flash off.

0.6 to 2.6m (1.97 to 8.53ft) in Wide; 0.6 to 1.7m(1.97 to 5.58ft) in Tele@ISO100
0.6 to 3.5m (1.97 to 11.48ft) in Wide; 0.6 to 2.1m(1.97 to 6.89ft) in Tele@ISO200

All information and menus are displayed on TFT LCD display, Review Image,
shows frame counter, flash status, self timer, focus mode, image quality, image
size, battery status and memory card.

User selectable Ul on TFT OSD menu. The languages included are Spanish,
Italian, German, English, French, Dutch, Simplified Chinese, Japanese
and Portuguese.

Slide Switch for Camera, Review, Video
Yes

Yes

Yes
Standard 1/4” size
Mini USB and TV/VCR Out

Mass Storage Driver for Window 98, 98SE,2000,ME, XP
Mass Storage Driver for Mac OS 9.x and Mac OS OS X

1 minute for LCD.
2 minutes or 3 minutes programmable auto power off for camera.

2x AA batteries, can use alkaline, lithium and rechargeable NiMH type
(Rechargeable NiMH type Highly Recommended)

100 x 61 x 31.5 mm without protrusions
160g without batteries and memory card

See the separate “Packing Content” sheet.
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SAFETY TIPS AND MAINTENANCE

Cleaning the camera body:
1. Please use a soft, dry and dust-free cloth to clean the camera.

Cleaning the lens, viewfinder and LCD:

1. Blow off dirt or dust with a blower or canned air.

2. Gently wipe the lens, viewfinder and/or LCD with a micro-fiber cloth.

3. To remove dirt or residue, moisten the cloth with lens cleaning fluid and gently wipe the lens, viewfinder

and/or LCD.

CAUTION: Do not apply the fluid directly onto the lens, viewfinder or LCD.

Cleaning the battery contacts:
As a matter of routine operation and handling, should any debris or foreign contaminant deposit itself on the
battery contacts in the camera and/or on the batteries, follow steps below to clean the battery contacts to ensure

proper electrical operation:
1. Wet the tip of a cotton bud/swab with rubbing alcohol and squeeze (with clean fingers) the excess alcohol

from the bud/swab.
2. Wipe the battery contacts inside the camera battery compartment and both ends of the batteries lightly with

the damp bud.
3. Allow the contacts to dry before placing batteries in the camera.

Caution:

1) Do not press hard during cleaning, as this will damage the battery contacts.

2) Do not use water to clean the contacts, as this will increase the chance of oxidation.

3) Do not use Acetone or Nail Polish remover to clean the contacts as this may adversely affect camera

operation.
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SAFETY TIPS

Precautions for the camera:

Do not attempt to modify this camera in any way. This may cause a fire, electric shock or severe damage to
the camera.

Do not use the flash in close proximity to people or animals.

When taking photographs, never point the lens of the camera directly into very strong light.

Please do not use this product in close proximity to flammable or explosive gases as this could increase the
risk of explosion.

For safety reasons keep this product and accessories out of reach of children or animals to prevent
accidents.

Do not swallow batteries or small camera accessories.

Keep the camera away from water and other liquids, and never let it get wet. Do not use the camera outdoors
outdoors amid rain, snow or hail.

Should any form of liquid enter the camera, do not use it. Switch the camera off, and then remove the
batteries. Do not continue to use the camera as this may cause a fire or electric shock.

Do not insert or drop metallic or inflammable foreign objects into the camera through access points e.g. card
slot and battery chamber. This may cause a fire or electric shock.

Do not operate this camera with wet hands. This could pose a risk of electric shock.

Under the environment with electrostatic discharge, the camera may malfunction and require the user to
reset the camera.

Under the environment with electrical fast transients (EFT), the camera may lose function and require user
to reset the camera.

Shielded cables must be used with this unit to ensure compliance with the Class B FCC limits.

Please avoid using the camera in high or low temperature. Operation temperature range 32°F - 104°F (0°C
-40°C).

It is normal that the temperature of the camera body rises after being in use for a long period.

Do not leave this camera in places subject to extremely high temperatures, such as in a sealed vehicle,
under direct sunlight, or in other places with extreme variances in temperature. Exposure to extreme
temperatures

may adversely affect the camera’s internal components and could cause a fire.

Always use the camera and its accessories in a well-ventilated area.

Allowing dust to accumulate in the camera over a long period of time is hazardous and in extreme
circumstances may cause a fire. It is best to clean your camera prior to seasonal periods of high humidity.

Precautions for batteries:

Use 2x AA batteries only.

Dispose of the batteries in a manner that complies with applicable laws.

Leakage, overheating, or burst batteries could result in fire or injury.

Do not short circuit, heat or dispose of batteries in fire.

Do not use old batteries with new ones, or mix brands of batteries.

Ensure the batteries are positioned correctly with regard to polarity (+/-).

Batteries may lose power if kept inside the camera for a long time without using. Please remove the
batteries while the camera is not in use.

Do not use manganese batteries as they cannot supply sufficient power to support the camera’s operations.
Batteries may not work normally under 32°F (0°C).

Precautions for SD Memory Cards:

In the event of malfunction or damage, it is possible that data may be lost. Concord Camera is not
responsible in any way for such data loss.

Do not touch the terminals with hands or metal objects.

Keep dust, liquid and direct sunlight when in used or when placed in storage

Avoid heat, liquid and direct sunlight when using and when storing.

Do not open the battery/card cover or remove the SD Memory Card while data is being read or written.

Do not dismantle or modify.

The recorded data may be lost if the card is affected by strong static electricity, electrical shock, during card
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repair or malfunction.

*  When using SD Memory Cards do not change the attributes (read-only, etc.) of the files (pictures (JPEG) or
video clips (AVI) on the card. Doing so may prevent the camera from working properly when deleting, etc.

« Do not change the file names or the directory name of the pictures or video clips using a computer or save
files other than pictures or video clips taken by this camera onto the SD memory card. Pictures or video
clips that have been edited or added to the SD memory card with the computer may not play back and it
may cause the camera to malfunction.

* The SD Memory Card includes a write-protect switch. Sliding this switch downward prevents data from
being written to the card and pictures and video clips saved on the card are protected.

« Please note that pictures and video clips cannot be taken or deleted when the write-protect switch is on.

« When using a large-capacity card, writing, reading and deleting may take some time.

« Do not store the card in places with high humidity, dusty places or where static electricity or electromagnetic
fields are likely to occur.

Images stored in the memory card may be ruined or damaged if you turn off the camera while it is in
process of reading, writing or formatting etc.

« SD cards are delicate electronic devices. Please do not bend or drop them

« Please do not place the SD card in or near to an environment of strong electronic or magnetic fields such as
loud speakers or TV receivers.

« Please keep the SD card in its bag or case when not in use.

« It's normal for the SD card to be warm after use.

« Please make sure you switch off the camera before you remove the SD card.

« Do not open the battery/memory card door or remove the SD Memory Card while the camera is reading,
writing or formatting the card.
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REGULATORY INFORMATION
FC Fcc INFormATION

FCC WARNING: This equipment meets the limits for a Class B digital device, pursuant to Part 15 of FCC rules.

Only the cable supplied with the camera should be used. Operation with other cables is likely to result in

interference to radio and TV reception and could void the user°@s authorization to operate this equipment. This

device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions:

» This device may not cause harmful interference.

« This device must accept any interference received, including interference that may cause undesired
operation.

Tested to comply
with FCC standards
for HOME OR OFFICE USE
Changes or modifications not expressly approved by the manufacturer may void the user°@s authority to operate
this equipment.

USER INFORMATION

NOTE: This equipment has been tested and found to comply with the limits for a class B digital device,
pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur in a
particular installation.

If this equipment does cause harmful interference to radio or television reception, which can be determined by
turning the equipment on and off, the user is encouraged to try to correct the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

+ Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

+ Consult the dealer or an experienced radio/TV technician for help.

VCCI INFORMATION

This is a Class B product, to be used in a domestic environment, based on the Technical Requirement of the
Voluntary Control Council for Interference (VCCI) from Information Technology Equipment. If this is used near
a radio or television receiver in a domestic environment, it may cause radio interference. Please install and use
the equipment according to this instruction manual.

c € - This product is in conformity with Directive 89/336/EEC.

The Jenoptik trademark is used by Concord Camera Corp. and its subsidiaries under license.

This product contains the software product of FUJIFILM “Exif Toolkit For Windows Ver.2.5 (Copyright (C) 1998-2004
FUJI PHOTO FILM CO.,LTD.). Exif is the image file format standard for digital still cameras stipulated by JEITA (Japan
Electronics and Information Technology Industries Association).
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